Operation Manual

Reconfigurable Reaction Wall (RRW)
Structural Test System

for University of California - Berkeley
MTS Job No. US1.21733.EQT

Sept 2003
# Table of Contents

## Section 1  System Overview

- Hydraulic System ............................................................................................................... 1-1
- Hydraulic Actuators ........................................................................................................... 1-2
- Servovalves ....................................................................................................................... 1-3
- Control System .................................................................................................................. 1-3

## Section 2  Operator's Safety Practices

- General Guidelines ............................................................................................................. 2-1
- Hazards Related to Unexpected Actuator Reactions ......................................................... 2-5

## Section 3  Understanding Control Principles

- Actuator Control Concepts ................................................................................................. 3-2
  - Basic Closed-Loop Control .......................................................................................... 3-2
  - Inner and Outer Closed-Loop Control ....................................................................... 3-3
- Differential Pressure Stabilization ..................................................................................... 3-5
- Test Adjustments ............................................................................................................... 3-6
  - Master Gain .................................................................................................................. 3-6
  - Span ............................................................................................................................... 3-7
  - Setpoint .......................................................................................................................... 3-8
  - Limit Detection .............................................................................................................. 3-9

## Section 4  Introduction to Control Software

- Setting Up Your Hard Disk ............................................................................................... 4-1
- Using the Structural Test System Software ....................................................................... 4-2
- The Structural Test System Main Panel .......................................................................... 4-5
- Main Panel Menus ............................................................................................................ 4-6
- Using the Software Controls ......................................................................................... 4-11
Section 5  Control Panel Reference

AC/DC Conditioners ............................................................................................................. 5-3
Analog Inputs .................................................................................................................. 5-6
Analog Outputs Scaling ........................................................................................................ 5-8
Analog Outputs ................................................................................................................ 5-10
Data Player .................................................................................................................... 5-11
Data Recorder ................................................................................................................ 5-13
Digital Meter A or B ........................................................................................................... 5-15
Digital Readouts ............................................................................................................. 5-19
Encoder Conditioners ...................................................................................................... 5-20
FRF Plotter ..................................................................................................................... 5-23
Function Generators ....................................................................................................... 5-26
Limit Detectors .............................................................................................................. 5-32
Main Panel ..................................................................................................................... 5-36
Message Log .................................................................................................................. 5-40
Oscilloscope .................................................................................................................... 5-41
PID Controllers .............................................................................................................. 5-44
Ramp Rates ..................................................................................................................... 5-50
Setpoints ...................................................................................................................... 5-52
Slaving Matrix ............................................................................................................... 5-54
Spectrum Analyzer ........................................................................................................... 5-56
Testpoint Units ............................................................................................................... 5-58
3 Stage Valve Driver ......................................................................................................... 5-59

Section 6  Operation

Pre-Test Adjustments ........................................................................................................... 6-2
Hydraulic Turn On Procedure ............................................................................................ 6-4
Warm-Up ......................................................................................................................... 6-7
Test Execution Procedure .................................................................................................. 6-8
Remote Control Pod Operation ......................................................................................... 6-10
Using the Low Flow/High Flow Shutoff System ............................................................... 6-13
Hydraulic Shutdown Procedure ....................................................................................... 6-15
Emergency Shutdown Procedure ..................................................................................... 6-16

Section 7  Maintenance

General Inspection .............................................................................................................. 7-1
System Operating Inspections .......................................................................................... 7-2
System Maintenance Log ................................................................................................. 7-7
Section 8  Calibration and Tuning

A/D Converters Calibration..................................................................................................... 8-1
D/A Converters Calibration..................................................................................................... 8-2
AC Conditioner Calibration..................................................................................................... 8-3
DC Conditioner Calibration..................................................................................................... 8-6
Linear Encoder Calibration..................................................................................................... 8-11
256 Inner Loop Valve Tuning................................................................................................... 8-13

Appendix A  Signal Name List
Section 1
System Overview

This section of the User's Manual provides a brief description of the Reconfigurable Reaction Wall (RRW) System designed by MTS Systems Corporation for the University of California - Berkeley. It also identifies the function of the major components used in this system.

The RRW system contains the following hardware:

- 7 actuators (3 static and 4 dynamic) that apply the forces necessary for specimen testing.

- Hydraulic Service Manifolds (HSM’s) and Hydraulic Distribution System (HDS) components that distribute hydraulic power to the system actuators.

- Control hardware that conditions, monitors, and generates program command and feedback signals for control of the test system.

- Digital control systems which provide computerized program management through the conversion of program command signals from digital to analog forms and the conversion of feedback signals from analog to digital forms. It also provides data acquisition, processing, and storage functions for data acquired during testing.

All of these major system components are discussed in the following subsections. It is important to note that these descriptions are generic in nature. More detailed information about each component, including engineering drawings, is included in appropriate sections of the system Reference Manual.

The system operator should obtain a good functional understanding of all major system components before attempting to operate the system. Failure to do so could lead to serious safety problems.

Hydraulic System

The primary components of the hydraulic system are the existing Hydraulic Power Supply (HPS), nine MTS Hydraulic Service Manifolds (HSM), and a variety of hose and hardline connections allowing multiple set-up options. Hydraulic fluid from the HPS system is distributed to and from the servovalves that control movement of the actuators. Hydraulic power for the RRW
system is controlled by the control system via the HSM on/off, low/high controls. Each HSM assembly also includes a pressure and return accumulator to reduce pressure fluctuation in the hydraulic system.

Hydraulic Actuators

The dynamic actuators used in the test system are specially designed, low-friction hydraulic actuators. Two 244.51S (220 kip) actuators and two 244.50S (150 kip) actuators are provided for this system. The actuators are attached to the specimen or reaction/mounting fixturing by robust MTS 249 series swivel assemblies.

The three static actuators used in the test system are specially designed 243.70 (216 kip). These actuators are also configured with robust MTS 249 series swivel assemblies for attachment of the specimen or reaction fixtures.

Actuator operation is accomplished by porting high-pressure hydraulic fluid into the actuator cylinders through the servovalve. As fluid is ported into the cylinder, pressure is applied to one side of the piston, the other side is opened to the
return line, and the piston moves. If the piston rod is connected to some external reaction point, a force is applied that is equal to the effective piston area times the actuating pressure. As the actuator drives the specimen mass, inertial forces are developed in direct proportion to displacement and frequency. A linear variable differential transformer (LVDT) is mounted inside each actuator to provide an electrical feedback signal that indicates the actuator piston rod position. An MTS high capacity 661 force transducer is equipped on each actuator to provide an electrical feedback signal that indicates the force exerted by the actuator.

**Servovalves**

The actuators are equipped with servovalves which control the direction and amount of fluid flow to the actuators.

For the dynamic actuator assemblies (244.50S and 244.51S units), both two-stage and three-stage valves are used. These actuators use a three-stage 256.40 servovalve providing 400 gpm flow with a 252.22 pilot valve providing 2.5 gpm.

The dynamic actuators are also configured with a low flow/high flow shutoff system that utilizes a 252.25 servovalve providing 15 gpm. This valve can be used to operate the actuator when less dynamic test conditions are required.

For the static actuator assemblies (243.70), units are configured with a 252.25 servovalve which provides 15 gpm of flow capacity.

**Control System**

There are two separate digital control platforms provided for the RRW system. The first is the MTS 493 Real-Time Controller that performs the real time, or near real time pseudo-dynamic structural testing capabilities. The second digital control platform is the MTS FlexTest GT Controller that provides a highly flexible and user configurable control environment to support more conventional structural testing applications.

The Real-Time Controller is a real-time, digital controller that provides PID closed loop control with a differential pressure transducer (delta-P) feedback signal. It also provides an operator interface to the real-time hardware from a PC over an Ethernet link. The control hardware architecture is based on Digital Signal Processing technology which optimizes the performance of the embedded control system, and allows for the implementation of advanced control and data filtering operations.
The controller system consists of a MTS console assembly, associated cabling and control software. The MTS console assembly has an imbedded processor and real-time hardware. The control software consists of the real-time control software and the control panel software. The real-time control software drives the processors to generate command and error signals. The control panel software runs on a PC and has a graphical user interface consisting of interactive, modeless dialogs that are used to enter system parameters and execute a test.

A separate operations manual is provided which documents the functionality and features of the Flextest controller and operating software.
Section 2
Operator’s Safety Practices

Overview

This section contains general operating safety techniques and precautions for operators of MTS testing systems. Your testing system operates within a unique environment that includes:

- Facility utilities, including mechanical and electrical equipment and atmosphere
- Test specimens
- Operator experience and specializations
- Equipment modifications you make to perform specific tasks

Because of these variables, the system could operate under unforeseen circumstances, resulting in an operating environment with unknown hazards. Common sense and a thorough knowledge of the system’s operating capabilities usually suggest the appropriate approach to system operation.

In addition to reading these guidelines, you should also read all supplied manuals. Anyone who operates an MTS system should also have had prior schooling and training on similar systems. MTS has training facilities for system operators and maintenance personnel to provide experience and training on MTS products.

General Guidelines

The following operating safety considerations are applicable to most systems. As you read each item, consider your system to ensure that your operating environment and procedures do not result in hazardous situations. Although complete elimination of hazards may not be possible in a laboratory environment, the following guidelines can help identify hazards so appropriate training, operating procedures, and safety equipment can be implemented. Contact an MTS representative if you have any questions.

System operators should gain an understanding of the system functions by studying the various drawings and product manuals in the system reference manual set. The reference manual set includes Assembly Drawings and Product Information. These drawings and manuals provide a good background for the structure and operating principles of the system.
Before operating the system for the first time, make a trial run through all operating procedures to locate and become familiar with all of the appropriate controls. If any operating adjustment seems unclear, review the operation and adjustment procedures listed in the associated product manual. If you need additional information, you can contact MTS for technical assistance.

Special points to consider when reading the manuals include:

- Locate all caution and warning notices for the known hazard characteristics of your system. These notices are located in the standard hardware product manuals provided in the system Reference Manual.

- Refer to the Operation Manual for step-by-step system operating procedures. If the operating procedures for your system change due to component modifications or other reasons, mark the changes in this manual to reflect the proper procedure.

Locate, read, and follow all instructions on equipment safety placards.

Locate all system Emergency Stop (or E-STOP) buttons on the system so you can quickly stop system operation in an emergency situation.

Use adequate eye protection when working with system fluids or near an operating system.

Never enter the test area while the test is in progress. Do not approach or touch the test specimen when the system is running. Ensure that hydraulic pressure is removed from the system before entering the test area.

Always keep work area floors clean. Spilled hydraulic fluid on any type of floor surface is dangerously slippery.

Do not make any mechanical or electrical adjustments to system components unless you know exactly how the adjustment will affect system operation. Consult your MTS representative if in doubt about any adjustment procedure.

System interlock devices should always be used and properly adjusted. Test all interlock devices for proper operation before starting a test. Due to the possibility of operator error, misadjustments, or component failure, interlock devices must not be relied on to protect personnel. These devices are primarily designed to minimize the chance of accidental damage to test specimens and test equipment.

Stay clear of cables and hoses that move along with the test specimen or equipment. Objects may get tangled or dragged along with such cables and hoses. Serious injury can be inflicted by a fast moving cable or hose.
### Avoid High Voltage Areas
High voltage is present inside the system control consoles. Avoid exposure to these areas when electrical power is applied. Avoid touching any exposed wiring or contacts anywhere in the system.

### Use Care When Charging Accumulators
Systems that use pneumatic devices (such as accumulators and static supports) contain high-pressure gas that is very hazardous if improperly handled or poorly maintained. Read all gas cylinder labels to properly identify the type of accumulator and the type of gas to use. Follow all charging instructions given in the appropriate manuals. When charging accumulators, use only dry nitrogen. (Dry nitrogen can be labeled “oil pumped” or “dry water pumped.”) Do not use oxygen in place of nitrogen. If oxygen comes in contact with pressurized hydraulic fluid, a highly explosive condition will exist. Contact your MTS representative if in doubt about any charging procedure.

### Maintain Electrical Cables in Good Condition
Protect electrical cables from spilled hydraulic fluid and from excessive temperatures that can cause cable hardening and eventual cable failure. Clean spilled hydraulic fluid from electrical cables as soon as possible. Inspect cables for cuts, exposed wires, or other types of damage prior to system operation. Ensure that cable connectors are securely plugged into their respective receptacles. Remove system electrical power before replacing a defective cable. Ensure that all cables have appropriate strain relief devices installed.

### Use Care When Routing Cables and Hoses
Protect all system cables and hoses from sharp or abrasive objects. Never walk on hoses or cables or move heavy objects over them. Route hoses and cables away from areas that expose them to possible damage.

### Check Hoses and Cables
Thoroughly inspect hoses for blisters, cuts, or other damage prior to system operation. Replace damaged hoses or cables. While the system is operating, inspect all hoses and cables to ensure that there is no excessive thrashing, bending, or chafing that could cause cable or hose damage.

### Be Aware of Servovalve Silting
Because of servovalve silting, an actuator can develop random instability or erratic operation at unusually low hydraulic pressure levels (such as bypass). This is even more common if the system uses large servovalves or the hydraulic fluid is dirty. Contact MTS for information on hydraulic fluid maintenance procedures.

### Flush Hydraulics
Flush the hydraulic system immediately after any of the system's hydraulic components have been replaced, or the system configuration has been changed. Contact MTS for information on hydraulic fluid maintenance procedures.
Use Caution When Handling Fire Resistant Hydraulic Fluids

Special safety considerations are necessary when operating a system that contains any type of fire resistant hydraulic fluid. These fluids are toxic and present a lethal situation if the fluid is accidentally swallowed or if a sufficient amount of fluid is absorbed through the skin. Avoid contacting fire resistant fluid. Do not mix fire resistant fluid with petroleum based fluids. Also, do not add fire resistant fluids to systems that are not compatible with these types of fluids.

Avoid System Crush Points

Stay away from any potential crush points, especially when the system is running. The system is capable of producing very high forces within a fraction of a second. Never assume that human reaction time is fast enough to escape injury. Know where the crush points are on your system and protect yourself and others with appropriate safety devices.

Use Care When Installing Test Specimen

Test specimen installation is potentially the most hazardous part of system operation. You are very close to or in contact with the system force train during installation. Exercise great caution to avoid crush points. Be sure to follow all provided installation instructions along with the following:

- Clear the work area, especially near crush points.
- Balance the servo control loop (reduce dc error to zero), use low hydraulic pressure, and ensure that the servo control system is stable. Be particularly alert for phase or control reversal if the system setup has been modified since the last time the system was operated.
- Do not bump, wiggle, adjust, or otherwise disturb a transducer that provides a feedback signal to the control system.
Hazards Related to Unexpected Actuator Reactions

Destructive forces can be generated from unexpected actuator response. Likely causes of such response are operator error and equipment failure (broken cables, damaged hoses, damaged electrical components, etc.). An actuator piston rod that reacts unexpectedly can strike an operator, or cause expensive equipment damage. Anyone who must be close to the system while hydraulic pressure is applied should acquire a thorough knowledge of the system's operating characteristics.

The following examples are some of the most probable causes of an unexpected actuator reaction.

Loss of Control Mode Feedback

If the control mode feedback signal is interrupted during operation, the active Controller senses a dc error. The actuator will then attempt to correct the error by stroking (at maximum velocity) until it reaches an internal or external mechanical limit. The external limit may be anything in its path (tools, specimens, or hands). Be aware that the full force of the actuator will be applied to that external limit or obstruction. Also, be aware of the following special points regarding the force-producing characteristics of hydraulic actuators:

- A selectable operating range does not reduce the static force capability of a hydraulic actuator. It only increases or decreases the sensitivity of the electronic control and readout components.

- The only way to effectively minimize the static force capability of a hydraulic system is to reduce the system hydraulic pressure.

- The control mode feedback originates from a transducer located in the system, and is transported to the control electronics through a transducer cable. This cable must be protected from damage to minimize the chance of unexpected actuator reaction. If the cable is routed around corners or through wall openings, ensure that all sharp edges are padded. Ensure that this cable has appropriate strain relief devices installed.

- The error detectors in the control electronics minimize the potential for equipment damage caused by loss of feedback or larger-than-normal dc errors. Do not rely on these circuits to protect personnel.

Loss of Servovalve Control Signal

An open control loop results if the cable from the control electronics to the servovalve is broken or disconnected while hydraulic pressure is applied to the system. The response of the actuator will depend on several different factors (piston rod position, the servovalve in use, etc.). In any case, actuator reaction can be violent. The same precautions that apply to transducer cables must be observed for servovalve cables.
Program Interruption and Step Functions

The composite command signal for the servo control loop usually consists of several program inputs such as program, command, setpoint, span, and master span. If one of these inputs is inadvertently removed or suddenly changed, the servo loop will detect a large instantaneous dc error and the actuator will respond accordingly.

Applying Hydraulic Pressure with a Command Present

When hydraulic pressure is not applied to the system, the actuator can drift down to its endcap unless restrained in some manner. If hydraulic pressure is applied again and the system is operating in static control, the actuator will quickly return to its previous position. The setting of the active Setpoint control is the determining factor in most cases. Always adjust the active Setpoint control to zero the servovalve command before applying hydraulic pressure.

Do not use any interlock reset to bypass the interlock chain and attempt to apply hydraulic pressure. Doing so will apply hydraulic pressure to the system regardless of the interlock condition.

Electrical Power Failure or Shutoff

Turning off electrical power, or an electrical power failure when hydraulic pressure is applied to the system, can cause considerable and unpredictable actuator reactions. Loss of electrical power generally causes the actuator to stroke at maximum velocity in either direction.

Over Programming

Unexpected actuator movement or excessive actuator force can result from operator error when adjusting a Setpoint or Span control. The composite command to the servo control loop is the algebraic sum of the signals produced by these controls. Either Setpoint or Span can program 100% of the system force producing capability. For example, in most systems a 10-volt signal produces full-scale response. If the program input to the control electronics is a 10-volt sine wave and Span is adjusted to 100%, any mean level offset introduced by the Setpoint control causes the command to exceed the capabilities of the system.
Section 3
Understanding Control Principles

Overview

This section contains information on the control principles used in the RRW Structural Test System. The following topics are discussed:

• Actuator Control Concepts
  - Basic Closed-Loop Control
  - Inner and Outer Closed-Loop Control

• Differential Pressure Stabilization

• Test Adjustments
  - Master Gain
  - Span
  - Setpoint

• Limit Detection

Before setting up the test system or executing a test, it is important that you fully understand these control elements.
Actuator Control Concepts

System motion is governed by movement of its actuators. Each actuator is controlled through basic closed-loop, inner and outer closed-loop. These basic servohydraulic control concepts are discussed in the following subsections.

Basic Closed-Loop Control

In general, closed-loop control consists of comparing a command signal with a feedback signal.

Consider the system schematically illustrated in Figure 3-1. In this system, a displacement command signal is generated by a program source that is outside of the control loop. Feedback is generated by a linear variable differential transformer (LVDT).

![Figure 3-1. Basic Closed-Loop Control](Image)

The polarity and magnitude of the dc error signal derived by the command/feedback comparison causes the servovalve spool to open in a direction and by an amount necessary to cause the desired actuator response. As the actuator responds, feedback approaches command. As the program input changes, the command/feedback comparison continuously generates dc error signals that drive the servovalve to create the desired actuator displacement. When command and feedback are equal, the dc error is reduced to zero, the servovalve spool closes, and the actuator does not move. This control method is referred to as "closed-loop control."

In addition to “gaining” the proportional error (described above), the system also gains the rate of the proportional error (derivative gain) and the duration of the proportional error (integral gain). This is the PID controller.
Inner and Outer Closed-Loop Control

The simplest form of closed-loop control, as described in the preceding subsection, is used in systems containing a standard one-stage servovalve. However, the large flow and frequency response requirements of seismic testing require the use of a multi-stage servovalve. The multi-stage servovalve (Figure 3-2) contains a spool LVDT that introduces a second loop into the basic closed-loop control system; the basic closed loop described above becomes an "outer" loop and the second loop becomes an "inner" loop.

The MTS Model 252 servovalve is used solely to drive the slave-stage spool. The spool LVDT provides a signal that is proportional to the position of the spool and that is, therefore, approximately proportional to the output flow of the servovalve.

![Multi-Stage Servovalve Diagram](image)

Figure 3-2. Multi-Stage Servovalve
Figure 3-3 schematically illustrates the inner and outer closed-loop control concept. As shown, the outer loop is similar to the basic closed-loop control concept discussed in the previous subsection. The dc error generated in the outer loop is the same as the dc error signal of the basic closed loop illustrated in Figure 3-1. This dc error signal is then applied to the inner loop as a valve command signal.

Figure 3-3. Inner and Outer Loop Control

The inner loop controls the position of the slave-stage spool in the same manner that the basic closed-loop concept controls the actuator. The inner loop summing junction produces a dc error signal that drives the slave-stage spool in the desired direction. This second loop enhances closed-loop performance to meet the hydraulic flow and frequency response requirements of the testing.
Differential Pressure Stabilization

Differential pressure stabilization is commonly used in MTS test systems to improve the fidelity of system performance. This function stabilizes the extremely high frequencies encountered during testing to provide more stable acceleration.

Differential pressure (ΔP) stabilization is applied to all electronically-controlled axes. The functional diagram in the following figure illustrates the application of ΔP stabilization in a single degree of freedom.
Test Adjustments

Master Gain Adjustment

Master gain is a multiplier applied to the error signal. It determines how quickly the controller responds to error. The greater the gain, the more the servovalve opens for a given error. As master gain is increased, the error decreases, indicating closer tracking of the feedback to the command. The following figure shows a step command and resulting transducer feedback signal with a small gain.

Increasing the master gain decreases the stability margin of the system, increases the frequency of oscillation, and decreases response time. The following figure shows the effect on the transducer feedback of increasing the master gain adjustment.

Setting the master gain too high can result in unstable system operation, causing specimen damage. Master gain should be set high enough to achieve an appropriate response time while maintaining stable system operation.
Span Adjustment

The maximum and minimum amplitude of a waveform output by a programmer is ±10 volts, which represents ±100% of the full-scale operating range. The master span control determines the amplitude of the command signal that is sent to the servo control process.

Setting the Span Controls

You set the span controls during test setup to scale the command signal. You can also make minor adjustments to the span control during the test.
Setpoint Adjustment

The maximum and minimum amplitudes of a waveform output by a programmer are ±10 volts, which represent 100% of the peak amplitude operating range. The local setpoint control changes the mean level offset of that program.

![Graph showing setpoint adjustment](Image)

Determining Setpoint Position

The setpoint position is the position about which the actuators will move during testing. For seismic testing, setpoint is typically the actuator midstroke position. If a different position is desired, you must ensure that the position does not limit the program capability.

For example, if you adjust a channel setpoint to +75% of the full-scale operating range, then any command that exceeds +25% of the full-scale range will shut down the test system when a full-scale system limit is encountered.

Setting the Setpoint Controls

You set Setpoint control during test setup. Refer to Section 6, Operation, for procedures used to adjust the setpoint controls.

Application for Structural Testing

In this structural system, setpoints can be used to load the structure being tested. In these cases, the setpoint adjustment attempts to change the actuator position, although, if there is insufficient available static force, the actuators will reach some steady state load controlled by the gains (see PID). This allows a mode-switching between setting a desired position setpoint versus a desired force setpoint. (See Setpoints panel)
Limit Detection

Limit detectors can be set to monitor any of the following signals:

- reference signals
- feedback signals
- error signals
- auxiliary signals

Limit Detector Settings
You set the following parameters for each limit detector: the operating band and a persistence value. The **operating band** defines the allowable range for the signal. The **persistence** value is a time, in seconds, that the signal can remain outside of the operating range before setting an indicator or interlock.

Limit Detector Actions
You can set an action to be taken when a limit or error is detected. The action can be any of the following:

- **Indicate** signal is outside of the limit. When the signal returns inside the limit, the indicator goes out.
- **Alert** – This selection causes the indicator to light and latch. When the signal returns inside the limit, the indicator remains lit until the **Reset** button is used. The out-of-limit condition will be recorded in the message log.
- **Pause** – This selection causes the indicator to light and latch, and the system will hold the current controller commands as they were when the signal violated the limit. When the signal returns inside the limit, the **Pause** button can be used to resume the signal from where it left off, the indicator remains lit until the **Reset** button is used. The out-of-limit condition will be recorded in the message log.
- **Program abort**– This selection causes the system to trigger an abort if the signal goes outside the limit. The **Reset** button is required to reset the system. The out-of-limit condition will be recorded in the message log.
- **Abort & switch to displ**– This selection causes the system to trigger an Abort if the signal goes outside the limit. If the system is in force control, it will switch to displacement control. The **Reset** button is required to reset the system. The out-of-limit condition will be recorded in the message log.
- **Interlock** – This selection causes the system to trigger an Emergency Stop if the signal goes outside the limit. The **Reset** button is required to reset the system. The out-of-limit condition will be recorded in the message log.

Refer to Section 5, *Control Panel Reference*, and Section 6, *Operation*, for additional information about setting the limit detectors.

Enabling Limits
After setting limit parameters, you enable the limit detectors and choose an action before running a test.
Error Detector

Error detectors are limit detectors that monitor the error signal, that is, the difference between the command and feedback, as shown in the following figure. An error detector can stop the test if an error in excess of the preset level is detected.

The level of acceptable error depends directly on the accuracy requirements of each testing situation.

**Setting Error Detectors**

You set the operating band and persistence for the error limit detector.

For static and low frequency testing, the initial error detector levels can be determined before beginning test setup. The level selected should reflect the response requirements of the specific test. For example, if the test can tolerate up to 25% deviation from the program signal, the error detector level can be set to 25%.

The error detector level can also be adjusted during testing if desired. Operator experience is the best guide for adjusting the error detectors for high frequency testing.
Feedback Limit Detectors

Feedback limit detectors monitor the feedback signals. As shown in the following figure, when a feedback signal exceeds its preset upper limit or falls below its preset lower limit, the corresponding limit detector can (if set to hold a program or trip the system interlock) stop the test.

Determining Limit Detector Levels

The limit detectors should be set to minimize the chances of accidental damage to test specimens and test equipment. They are typically set to shut down the system upon specimen failure in order to prevent fixturing or equipment damage. Under no circumstances should the limit detectors be relied on to protect personnel.

Setting Limit Detectors

You set the operating band and persistence for each feedback limit detector.

A limit event for a particular signal indicates that the signal has exceeded its upper or lower limit. The selected band establishes a range of values that represent a desired system operating range. This band also represents the range where valid test data can be ensured. The persistence value is a time (in seconds) that an upper or lower out-of-limit condition can persist without causing an interlock.
Section 4
Introduction to Control Software

Overview

This section contains information on the following topics:

• Setting up your hard disk
• Using the Structural Test System software
• Using the software control panels

This manual does not describe standard PC procedures. Before using the system, you should be familiar with your PC operating system. Of particular importance are the procedures relating to selecting and moving files, opening and closing files, moving windows, and using file folders. For information about the PC, refer to the PC documentation provided with your system.

Setting Up Your Hard Disk

To run the Structural Test System software, the application and support files must be installed on your PC.

NOTE
The application and support files listed below have already been installed on the computer system by MTS during installation. The following procedure for installing the programs should only be done in the event of a hard disk failure or other event that corrupts the disk or software files.

Required Files

The files named *sts.exe*, and *Settings.set*, and the folder *bin* must be installed on your hard drive in the folder, “c:\sts”. These files contain the Structural Test System application software, default setting parameters, calibration parameters and system specific data for your system.

Backup Copies

MTS recommends that you make backup copies of the Structural Test System application and support files. Keep this backup copy in a safe place to ensure that, if a file is corrupted during operation, you can restore the file and operate your system.
Using the Structural Test System Software

This section describes how to start the control software, load calibration parameters, save and restore system settings files, and quit the control software.

**Starting the Control Software**

The Structural Test System application contains the control software, calibration data, and the default setting parameters for your system. Opening this application will load the calibration parameters and open the Structural Test System Main Panel and the default Settings file.

**NOTE** After you use the control software to set up the system for a test, you can save the system settings in a new file. During system startup, the system automatically opens the default Settings file. You can select and use a different "settings" file after system startup.

The Structural Test System main panel is the control center of this application. You can use the menus of this panel to access all options for calibrating, configuring, setting up tests, and displaying data. You can also use the controls and displays of this panel to set or check functions, and to run a test.

**Saving and Restoring System Settings Files**

When you set up your system for a test, you will complete a number of procedures defining the system test settings. These settings include servo control loop adjustments, limit detector settings, and function generator settings. These settings will be stored in Settings.set or a settings file of your choice.

**Calibration File**

The hardware dependant parameters for the system are also stored in Settings.set which is automatically loaded when the application is opened. This file contains calibration data for the A/D and D/A Converters, DC Conditioners, AC Conditioners and Valve Drivers. Hardware is calibrated using the panels found under the Calibration menu and new parameters are saved using the Save Settings option. If needed, you can restore the parameters stored in the calibration file by selecting the Restore Settings option. This is useful if you change parameters on any of the calibration panels and wish to return to the original values.

**NOTE** When you save a system settings file, use the Save Settings option from the File menu on the Structural Test System Main Panel.
You can save these settings files and use them when running different types of tests. In this way, you can eliminate the need for re-defining the system parameters when running a different type of test.

You can choose to save system settings for a test in the same file you are currently using to run the software or in a new file. When saving a settings file, you should name the file in a way that makes it easily identifiable.

To save system settings:

1. Select **Save Settings...** from the main panel File menu. When you select **Save Settings...**, the system will open a PC Save window.

2. To save system settings in the same file you are currently using:
   Using standard PC file procedures, select the folder containing the existing settings file. Do not change the file name.

   To save system settings in a new file:
   Using standard PC file procedures, select the folder that you want to save the new settings file in and change the file name.

3. Click the **OK** button to save the file in the selected folder (or click **Cancel** to cancel the procedure, close the save window, and return to the Structural Test System Main Panel).

To restore a system settings file that has been saved:

1. Select **Restore Settings...** from the Structural Test System Main Panel File menu. The system will open a PC Find window.

2. Using standard PC file procedures, select the file that contains the system settings that you want to use.

3. Click the **OK** button to restore the selected file (or click **Cancel** to cancel the procedure, close the find window, and return to the Structural Test System Main Panel).

Changing Access Modes

To change the access mode, select **Change Access** from the main panel File menu and select the desired access level. The current access level will have an *.

The available access modes are:

**Basic** — The basic user can adjust variables on the main panel and run a test along with setting up the function generators and the data recorder, and using all the display panels. The basic user can only observe the calibration and configuration panels, the controller panels, and the limit detector panel.

**Extended** — The extended user is responsible for setting up or designing a test and has access to all the parameters on all the panels.

**Service** — For MTS service personnel only.
Quitting the Control Software

To ensure you do not accidentally close the control software application, the close box on the Structural Test System Main Panel is not functional. To quit the control software, complete the following steps:

1. Select **Quit** from the File menu on the Structural Test System Main Panel. When you select Quit, the system will open the following window:

   ![Quit Confirmation Window]

   **Do you really want to quit?**

   - Okay
   - Cancel

2. Select **OK** to quit or **Cancel** to return to the control software without quitting.

---

**NOTE**  
After you have selected **Okay** to Quit, you must wait 45 seconds before restarting the software. This allows the software to properly prepare for startup.
The Structural Test System Main Panel

As previously described, the Main Panel contains a menu bar, system controls, and indicators. It is opened automatically when you start the control software. You use the menus on the Structural Test System Main Panel to access option panels used to set up the system. The following menus are included on the main panel:

- File
- Calibration
- Configuration
- Operation
- View

The main panel also has system controls and indicators which allow the user to do the following:

- Enable and Monitor hydraulics
- Reset Interlocks
- Enable/disable limits
- Select program source
- Set master gain and span values
- Monitor current span
- Stop, Run, Pause or Abort a test

Refer to the Main Panel in Section 5, Control Panel Reference, for more detailed information on how to use the main panel controls and indicators.
Main PanelMenus

The following figures illustrate the pulldown menus and corresponding option panels and commands available from the main panel. Option panels are used to set up a test. Each option panel contains a panel label, a close box, and controls and displays specific to the option panel.

Each main panel menu and corresponding commands and control panels are defined below. Refer to the following section, Control Panel Reference, for more detailed explanations on how to use each panel.

File

Use the commands on this menu to perform the following tasks (tasks marked with an asterisk (*) are available only to users with extended or service access privileges):

- **About STS**… - displays current software version and copy rights
- **Change Access** - change access level (Basic, Extended or Service)
- **Change Password** - create or change the password for access privileges*
- **Translate text to binary** - translates data files from text to MTS binary format. This can be used to translate a playout file. Refer to the Function Generator panel in Section 5 of this manual.
- **Translate binary to text** - translates data files from MTS binary to text format. This can be used to translate data acquisition files. Refer to the Data Recorder panel in Section 5 of this manual.
- **Restore settings** - restore Structural settings from an existing disk file*
- **Save settings** - save Structural Controller settings to a disk file*
- **Quit** - quit from Structural Controller application
Calibration

Use the commands on this menu to calibrate the following devices:

- Analog Inputs
- Analog Outputs
- AC/DC Conditioners
- Encoder Conditioners
- 3-Stage Valve Drivers

Configuration

Use the commands on this menu to configure the following:

- Ramp Rates
- Slaving Matrix
- Testpoint Units
Use the commands on this menu to perform the following tasks:

- **Controllers**- set parameters for PID Controllers
- **Data Player**- select a time history file as the program source
- **Data Recorder**- set up data acquisition to a file
- **Function Generators**- set parameters for function generators
- **Limit Detectors**- setup limit detectors
- **Setpoints**- setup setpoints
- **Spectrum Analyzer**- set parameters for spectrum analyzer
Use the commands on this menu to display data on the following types of panels:

- **Analog Readouts**- to route a digital signal to a D/A converter for monitoring by external analog equipment
- **Digital Meters A and B**- to read the present value of a signal and to monitor the maximum/minimum values, or the peak/valley values over time
- **Digital Readouts**- to display the present value of one or more signals
- **FRF Plotter**- to plot the FRF (frequency response function) to show frequency responses computed by the Spectrum Analyzer
- **Message Log**- display current messages in the message log
- **Oscilloscope**- display oscilloscope traces of various signals
Selecting an Option from a Main Panel Menu

To access a control panel from a main panel menu, complete the following steps:

1. Click on the menu title associated with the option you want to access.
2. Move the mouse to highlight the option you want to access.
3. When the option is highlighted, click the mouse button again.

When you release the mouse button, the panel associated with the option will open automatically and become the active panel.

Making a Control Panel Active

Although more than one control panel can be open at the same time, only one panel can be active at a time. You can enter information and use the controls only on the active panel.

When you first open a panel, it automatically becomes the active panel and you can use the panel’s controls. To make a different panel active, click anywhere on that panel. When you do this, the panel will be redrawn on the top of the other panel(s) and become active.

NOTE
When switching from one panel to another, the first mouse click only activates the panel. The first click is not directed at a control, regardless of the pointer position.

Closing a Control Panel

Each control panel has a close box in its upper right-hand corner. To close a control panel, click on the close box when the panel is active.
Using the Software Panel Controls

The control panels contain a variety of controls that you use to make selections and enter test parameters. You use the controls by moving and clicking the mouse.

The panel controls are illustrated and described in the following table.

Table 1-1. Software Panel Control Descriptions

<table>
<thead>
<tr>
<th>Control or Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check Boxes</strong></td>
<td><em>Check boxes</em> are used when you can select any option in a set of options. A selected check box shows a check mark. Click on a check box to select or deselect its option.</td>
</tr>
<tr>
<td>✔ Autoscale</td>
<td></td>
</tr>
<tr>
<td>✔ Same scale</td>
<td></td>
</tr>
<tr>
<td><strong>Function Buttons</strong></td>
<td>Click a <em>function button</em> to complete the function associated with the button. Some of the most common function buttons are illustrated at the left. The Stop, Preview and Run buttons are used to system. The Select..., Next, and Previous buttons are used to select a channel or signal for which you want to enter information. Any function button that has an ellipsis (...) following its label accesses a secondary panel. For example, the Select... button shown at the left accesses a selection panel, from which you select a channel or signal.</td>
</tr>
<tr>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td></td>
</tr>
<tr>
<td>Run</td>
<td></td>
</tr>
<tr>
<td>Select...</td>
<td></td>
</tr>
<tr>
<td>Next</td>
<td></td>
</tr>
<tr>
<td>Previous</td>
<td></td>
</tr>
<tr>
<td><strong>Indicators</strong></td>
<td>An <em>Indicator</em> is a small circle that identifies a specific condition in the test system. The condition, identified by the label associated with the indicator, exists if the indicator is filled (like the Tracking indicator shown on the left). The indicators in the control panels are set by the control electronics. Refer to the appropriate description in Section 5, <em>Control Panel Reference</em>, for more information about a specific indicator and, if applicable, for instructions on clearing an indicator.</td>
</tr>
<tr>
<td><img src="image" alt="Tracking Indicator" /></td>
<td></td>
</tr>
<tr>
<td>Control or Display</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Pulldown Menus</strong></td>
<td>A pulldown menu is used to select one option from a list of options. To display the selections on a pulldown menu, click and hold on the pulldown menu field until the menu appears. Move the mouse to highlight the option you want to select and then release the mouse button.</td>
</tr>
<tr>
<td><img src="image" alt="Configuration" /></td>
<td><strong>Observers</strong>&lt;br&gt;<strong>Ramp Rates</strong>&lt;br&gt;<strong>Units</strong></td>
</tr>
<tr>
<td><strong>Radio Buttons</strong></td>
<td>Radio buttons are used when you can select only one option in a set of options. The selected radio button is the one with the darkened center. Click on a radio button to select an option. When you select one of the radio buttons in the set, the other button(s) in that set are automatically deselected.</td>
</tr>
<tr>
<td><img src="image" alt="Display mode" /></td>
<td><strong>Display mode</strong>&lt;br&gt;<strong>Time</strong>&lt;br&gt;<strong>Freq</strong>&lt;br&gt;<strong>X-Y</strong></td>
</tr>
</tbody>
</table>
| **Scroll Bars** | A scroll bar can be used to view all available selections in a selection box or all available messages in the Message Log. To view selections or messages, use the scroll bar in one of the following ways:  
- Click and hold or click repeatedly on the scroll bar arrows to “scroll” through the selection/message list.  
- Click and then drag the box in the scroll bar to move through the selection/message list.  
- Click on the bar outside of the box to “jump” through the available selections/messages. |
| ![Scroll Bar](image) | ![Message Log](image) |
A slide bar is used to enter numeric values in the system. Each slide bar is associated with a specific signal or value, which is identified by the label on the slide bar. The current value is shown in a text box above the bar. The units associated with the signal or value are also identified on the slide bar.

Change the value identified on a slide bar in one of the following ways:

- Click and hold or click repeatedly on the slide bar arrows to “scroll” through the range of values.
- Click and hold, and then drag the box in the slide bar to change the value.
- Click on the arrow on either side of the box to “jump” through the range of values.
- Highlight the text box, type in the desired value and then press the return key on the keyboard. A quick double click highlights existing text in the entire box. Typing then replaces the box contents.

Each slide bar has a defined range. For example, the range of the Master gain slide bar is 0 to 100%. You can change the range associated with a slide bar by clicking on one of the small striped rectangles at the end of the bar. After clicking on the rectangle, type the value desired and press the return key to enter the new range value in the system. To cancel without entering a new range value, click on the striped rectangle again.

One mouse click on the slide bar moves the current value of the adjustment by 1% of the full range.

(Slide Bars continued on next page)
### Table 1-1 (con’t). Software Panel Control Descriptions

<table>
<thead>
<tr>
<th>Control or Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slide Bars (continued)</td>
<td>This also affects scrolling resolution. To increase the scrolling resolution, reduce the range.</td>
</tr>
<tr>
<td></td>
<td><strong>WARNING</strong></td>
</tr>
<tr>
<td></td>
<td>If the range is large, small movements of the slide bar can cause large changes in the control loop. Unexpected actuator action could result. Unexpected actuator action can cause injury to personnel or damage to equipment.</td>
</tr>
<tr>
<td></td>
<td>To avoid injury or damage, use a small enough range to ensure that no major control system motions occur.</td>
</tr>
<tr>
<td>Status Buttons (with indicator)</td>
<td>A status button is a function button that is linked to an indicator. The function is selected by the button, and the status of the function is identified by the indicator.</td>
</tr>
<tr>
<td></td>
<td>For example, the HPS On status button changes the state of the hydraulic power supplies.</td>
</tr>
<tr>
<td>Text boxes</td>
<td>A <em>text box</em> contains current selections, selection information, or alphanumeric data. Some text boxes are editable and some are not editable.</td>
</tr>
<tr>
<td></td>
<td>To change the entry in a <em>selection text box</em> you have to use functions buttons associated with the field (for example, a Select... button). The name of the entry can be changed by selecting the text in the box, typing the desired name over it, and then pressing the return key. (Double clicking on the text will select all of it).</td>
</tr>
<tr>
<td></td>
<td>A <em>display text box</em> is not editable, but is updated whenever you change the associated selection. An example of this type of text box is the Chan text box shown on the left.</td>
</tr>
<tr>
<td></td>
<td>An <em>alphanumeric text box</em> is used to enter data into the system. Examples of this type of text box are the text boxes shown on the left. To change the data in a text box, select the existing text, type the desired information over it, and then press the return key.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>1/01/A</th>
<th>X1 Displacement fbk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setpoint rate</td>
<td>25.0</td>
<td>%FS/s</td>
</tr>
<tr>
<td>Setpoint accel</td>
<td>100.0</td>
<td>%FS/s²</td>
</tr>
<tr>
<td>Frequency rate</td>
<td>2.0</td>
<td>Hz/s</td>
</tr>
<tr>
<td>Phase rate</td>
<td>45.0</td>
<td>deg/s</td>
</tr>
</tbody>
</table>
Section 5
Control Panel Reference

Overview

This section contains alphabetically arranged descriptions for each control panel in the Structural Test System software.

⚠️ WARNING ⚠️

For most options, a control panel is automatically opened when you select the option. These control panels display current settings.

Before you change a displayed setting, know the effect the change will have on the system. Refer to Section 6, Operation, before adjusting any value or attempting to operate the system.
The following table identifies each panel described in this section, as well as its corresponding option name and menu location. Refer to Section 4, *Introduction to Control Software*, for information on how to select these menu options.

<table>
<thead>
<tr>
<th>Panel Name</th>
<th>Menu</th>
<th>Menu Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC/DC Conditioners</td>
<td>Calibration</td>
<td>AC/DC Conditioners</td>
</tr>
<tr>
<td>Analog Inputs</td>
<td>Calibration</td>
<td>Analog Inputs</td>
</tr>
<tr>
<td>Analog Output Scaling</td>
<td>Calibration</td>
<td>Analog Outputs</td>
</tr>
<tr>
<td>Analog Outputs</td>
<td>View</td>
<td>Analog Readouts</td>
</tr>
<tr>
<td>Data Player</td>
<td>Operation</td>
<td>Data Player</td>
</tr>
<tr>
<td>Data Recorder</td>
<td>Operation</td>
<td>Data Recorder</td>
</tr>
<tr>
<td>Digital Meter A or B</td>
<td>View</td>
<td>Digital Meter A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digital Meter B</td>
</tr>
<tr>
<td>Digital Readouts</td>
<td>View</td>
<td>Digital Readouts</td>
</tr>
<tr>
<td>Encoder Conditioners</td>
<td>Calibration</td>
<td>Encoder Conditioners</td>
</tr>
<tr>
<td>Frequency Response Function Plotter</td>
<td>View</td>
<td>FRF Plotter</td>
</tr>
<tr>
<td>Function Generators</td>
<td>Operation</td>
<td>Function Generators</td>
</tr>
<tr>
<td>Limit Detectors</td>
<td>Operation</td>
<td>Limit Detectors</td>
</tr>
<tr>
<td>Main Panel</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Message Log</td>
<td>View</td>
<td>Message Log</td>
</tr>
<tr>
<td>Oscilloscope</td>
<td>View</td>
<td>Oscilloscope</td>
</tr>
<tr>
<td>PID Controllers</td>
<td>Operation</td>
<td>Controllers</td>
</tr>
<tr>
<td>Ramp Rates</td>
<td>Configuration</td>
<td>Ramp Rates</td>
</tr>
<tr>
<td>Setpoints</td>
<td>Operation</td>
<td>Setpoints</td>
</tr>
<tr>
<td>Slaving Matrix</td>
<td>Configuration</td>
<td>Slaving Matrix</td>
</tr>
<tr>
<td>Spectrum Analyzer</td>
<td>Operation</td>
<td>Spectrum Analyzer</td>
</tr>
<tr>
<td>Testpoint Units</td>
<td>Configuration</td>
<td>Testpoint Units</td>
</tr>
<tr>
<td>3-Stage Valve Drivers</td>
<td>Calibration</td>
<td>2-Stage Valve Drivers</td>
</tr>
</tbody>
</table>
AC/DC Conditioners

Panels Description

The Conditioners panel allows you to perform the following tasks:

- Select a specific AC or DC conditioner
- Calibrate the conditioner to its associated transducer
- Select polarity of output
- Select filtering option
- Set hardware limits for the conditioner output (feedback)
- Identify whether an interlock has occurred
- Disable and/or reset interlocks
AC/DC Conditioners (continued)

**Access**
Open the Conditioners panel by selecting the Conditioners option from the Calibration menu on the main panel.

**When to Use the Panel**
Use the Conditioners panel to calibrate a conditioner with its associated transducer and to identify and reset hardware interlocks. Whenever a transducer is replaced or moved, the associated conditioner should be calibrated. Hardware limits should be checked and reset before starting a test. In addition, MTS recommends verifying calibration values periodically.

**Control Descriptions**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cond text box</td>
<td>Shows the name of the currently selected conditioner. The adjacent conditioner ID box shows the slot number of the selected conditioner. Select a conditioner using the Select…, Next, or Previous buttons.</td>
</tr>
<tr>
<td>Select… button</td>
<td>Opens the conditioner selection panel, from which you can select a conditioner.</td>
</tr>
<tr>
<td>Next button</td>
<td>Selects the next conditioner in the selection panel list.</td>
</tr>
<tr>
<td>Previous button</td>
<td>Selects the preceding conditioner in the selection panel list.</td>
</tr>
<tr>
<td>Excitation mode pop-up</td>
<td>Displays the type of conditioner selected; AC or DC.</td>
</tr>
<tr>
<td>Excitation ampl slide bar and text box</td>
<td>Sets the amplitude of the excitation signal sent to the transducer. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td>Excitation freq pop up menu</td>
<td>(Available for AC excitation mode only) Selects the frequency of the excitation signal sent to the transducer.</td>
</tr>
<tr>
<td>Demod. phase slide bar and text box</td>
<td>(Available for AC excitation mode only) Sets the demodulator phase of the AC conditioner output. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td>Zero slide bar and text box</td>
<td>Sets the dc offset of the conditioner output. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td>Gain slide bar and text box</td>
<td>Sets the total gain of the conditioner. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td>Delta K (+) slide bar and text box</td>
<td>Sets the delta K (+) value for the conditioner. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
</tbody>
</table>
### AC/DC Conditioners (continued)

#### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter cutoff</strong> pop-up menu</td>
<td>Select the desired output filter cutoff frequency.</td>
</tr>
<tr>
<td><strong>Invert Polarity</strong> check box</td>
<td>Selects the polarity of the output signal. The choices are: Inverted or noninverted.</td>
</tr>
<tr>
<td><strong>Shunt cal</strong> button</td>
<td>(Available for DC excitation mode only) Closes the shunt calibration relay to complete a shunt calibration of the conditioner and displays the value in the Conditioner Output value display.</td>
</tr>
<tr>
<td><strong>Interlocks</strong></td>
<td></td>
</tr>
<tr>
<td>Disabled check box</td>
<td>When checked, disables hardware interlocks for this channel.</td>
</tr>
<tr>
<td>Reset button</td>
<td>When pressed, resets the hardware interlocks for this channel.</td>
</tr>
<tr>
<td>Watchdog timer indicator</td>
<td>Indicates the state of the watchdog timer.</td>
</tr>
<tr>
<td><strong>Excitation fail</strong> indicator</td>
<td>Shows whether excitation has failed. This detector is always enabled, both in hardware and software. Excitation failure causes a system interlock because it may indicate a broken, defective or missing conditioner cable.</td>
</tr>
<tr>
<td><strong>Limit</strong> indicator</td>
<td>Indicates whether the conditioner output has gone outside of the limits set using the Upper and Lower Limits slide bars.</td>
</tr>
<tr>
<td><strong>Upper Limit</strong> slide bar and text box</td>
<td>Sets the upper limit of the conditioner output. You can use the slide bar to set a value or you can enter it in the text box. If the conditioner output (feedback) has exceeded this limit, the Limit indicator is lit.</td>
</tr>
<tr>
<td><strong>Lower Limit</strong> slide bar and text box</td>
<td>Sets the lower limit of the conditioner output. You can use the slide bar to set a value or you can enter it in the text box. If the conditioner output (feedback) has exceeded this limit, the Limit indicator is lit.</td>
</tr>
<tr>
<td><strong>Engineering Units</strong> display box</td>
<td>Sets the engineering value that equates to ± 10 volts.</td>
</tr>
<tr>
<td><strong>Conditioner output</strong> text box</td>
<td>Shows the value of the signal output by the selected conditioner. The upper box gives the voltage; the lower value is in engineering units. Not editable.</td>
</tr>
</tbody>
</table>
Analog Inputs

Panel Description

The Analog Inputs panel allows you to perform the following tasks:

- Select a specific analog-to-digital (A/D) converter
- Adjust the offset and gain for the selected converter
- Define engineering units for the selected converter
- View the current voltage output value at the selected converter

Access

Open the Analog Inputs panel by selecting the Analog Inputs option from the Calibration menu on the main panel.

When to Use the Panel

Use the Analog Inputs panel to periodically calibrate the A/D converters (or ADCs) in the system to ensure that the input and output voltages are balanced.

NOTE  Both offset and gain are saved in the Settings.set file.
Analog Inputs (continued)

Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conv text box</td>
<td>Shows the name of the currently selected channel. The adjacent channel ID box shows the number of the selected channel. Select a channel using the Select..., Next, or Previous buttons.</td>
</tr>
<tr>
<td>Select... button</td>
<td>Opens the converter selection panel, from which you can select a converter.</td>
</tr>
<tr>
<td>Next button</td>
<td>Selects the next converter in the selection panel list.</td>
</tr>
<tr>
<td>Previous button</td>
<td>Selects the preceding converter in the selection panel list.</td>
</tr>
<tr>
<td>Offset slide bar and text box</td>
<td>Adjusts the offset of the signal output by the converter. Use the Offset slide bar to set the A/D Converter for a current value of 0.00V. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td>Gain slide bar and text box</td>
<td>Adjusts the gain of the signal output by the converter. Use the Gain adjustment to set the full-scale range of the A/D Converter. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td>Engineering Units text boxes</td>
<td>Shows the ±10 voltage values that equate to the inputted engineering value.</td>
</tr>
<tr>
<td>Current value text boxes</td>
<td>Shows the current value output by the selected converter. Not editable.</td>
</tr>
</tbody>
</table>
Analog Output Scaling

The Analog Output Scaling panel allows you to perform the following tasks:

- Select a specific digital-to-analog (D/A) converter
- Adjust the offset and gain for the selected converter
- View the current voltage output value at the selected converter

Access

Open the Analog Output Scaling panel by selecting the Analog Outputs option from the Calibration menu on the main panel.

When to Use the Panel

Use the Analog Output Scaling panel to ensure that the input and output voltages are balanced.

Normally you do not need to calibrate D/A converters (or DACs). Any D/A converter calibration should be completed only by experienced MTS service personnel.

NOTE Both offset and gain are saved in the Settings.set file.
### Analog Output Scaling (continued)

#### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conv</strong> text box</td>
<td>Shows the name of the currently selected channel. The adjacent channel ID box shows the number of the selected channel. Select a channel using the <strong>Select...</strong>, <strong>Next</strong>, or <strong>Previous</strong> buttons.</td>
</tr>
<tr>
<td><strong>Select...</strong> button</td>
<td>Opens the converter selection panel, from which you can select a converter.</td>
</tr>
<tr>
<td><strong>Next</strong> button</td>
<td>Selects the next converter in the selection panel list.</td>
</tr>
<tr>
<td><strong>Previous</strong> button</td>
<td>Selects the preceding converter in the selection panel list.</td>
</tr>
<tr>
<td><strong>Offset</strong> slide bar and text box</td>
<td>Adjusts the offset of the signal output by the converter. Use the <strong>Offset</strong> slide bar to set the D/A Converter for a current value of 0.00V. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td><strong>Gain</strong> slide bar and text box</td>
<td>Adjusts the gain of the signal output by the converter. Use the <strong>Gain</strong> adjustment to set the full-scale range of the D/A Converter. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td><strong>Current value</strong> text box</td>
<td>Shows the current value output by the selected converter. Not editable.</td>
</tr>
</tbody>
</table>
Analog Outputs

The Analog Outputs panel allows you to select a signal to be outputted to a D/A converter.

Access
Open the Analog Outputs panel by selecting the Analog Readouts from the View menu on the main panel.

When to Use the Panel
Use this panel to select a signal to be written to an auxiliary D/A converter.

Refer to Appendix A for a list of the available signals.

Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Name</td>
<td>Click near any number to open a pulldown channel selection box. Select a channel. The name of the selected channel is displayed.</td>
</tr>
</tbody>
</table>

NOTE
The engineering units associated with ±10 volts output of the D/A converters can be read from the Testpoint Units panel.

Additional scaling and offsetting of the D/A converter outputs can be done via the Analog Output Scaling panel.
**Data Player**

The Data Player panel allows you to list the data channels and select a time history file for the program source.

**Access**

Open the Data Player panel by selecting the Data Player option from the **Operation** menu on the main panel. You can also open this panel by clicking on the **Program Source** icon on the Main panel when Data Player File is selected.

**When to Use the Panel**

Use the Data Player panel to list the data channels and choose a file to be played out as the program source when the Data Player selection is enabled for the program source on the Main panel.

First choose the desired channels and then select the file. It is very important that the number of channels and order of channels selected match the number and order in the selected file.

Tip: Always keep the natural order of channels as they are listed by the software in the Available list.

**Playout File Information**

When using a file for the playout source, the file must be in MTS binary format. The **Translate text to binary** option under the File menu on the Main panel will translate an ASCII text file to MTS binary format.

The text file to be translated must be in the following format:

The first value in the text file must be the time period between samples, followed by the data in engineering units arranged in a single column.

The translator will prompt you for the ASCII text file. The converted file will be given the same name as the text filename but will have a `.bin` extension.
Data Player (continued)

**Playout File Information (con’t)**

Note that when a file is played out, the system does not automatically ramp up at the beginning of the file. It is assumed the file will contain this ramping data if it is required. The span will jump to 100% at the beginning of the file. The only exception to this is in the middle of the file, if the program is put into Stop mode, then the system will ramp down to 0% and ramp back up to 100% when it starts up again (Run mode enabled).

You can scale the playout file by playing it out at a different sample rate than the recorded rate. The **Play Sample Period** input allows the user to input a playout sample period different from the recorded sample period.

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File... button and text box</strong></td>
<td>Selects the file which contains the playout data. The file must be in MTS binary format. The Translate text to binary option under the File menu on the Main panel can be used to convert an ascii text file to MTS Binary format.</td>
</tr>
<tr>
<td><strong>File Sample Period</strong> text window</td>
<td>Displays the sample period of the recorded file.</td>
</tr>
<tr>
<td><strong>Play Sample Period</strong> text box</td>
<td>Input the desired sample period for playing out the recorded file. This value will default to the File Sample Period.</td>
</tr>
<tr>
<td><strong>File Length</strong> text window</td>
<td>Displays the playout file length.</td>
</tr>
<tr>
<td><strong>Elapsed Time</strong> text window</td>
<td>Displays the amount of time that the file has been played out.</td>
</tr>
<tr>
<td><strong>Pass _ of _</strong> text boxes</td>
<td>Input the number of times to play the selected file. The current pass will be displayed.</td>
</tr>
<tr>
<td><strong>Reset</strong> button</td>
<td>When pressed, resets the playout file to the beginning.</td>
</tr>
<tr>
<td><strong>Channel Selection</strong> text boxes</td>
<td>Select the channels to be played out. The <strong>Available</strong> box shows the available channels. The <strong>Selected</strong> box shows the selected channels. To move a channel between boxes, first highlight the channel by placing the cursor on it and clicking once on the mouse button. Then click on the appropriate arrow to move the channel to the other box. Press the <strong>Reset</strong> button to clear the Selected box of all channels. Make sure the number of channels selected and the order of these selected channels matches the number and order in the selected playout file.</td>
</tr>
</tbody>
</table>
Data Recorder

Panel Description

The Data Recorder panel allows you to:

- Record data from selected channels and store in a user selected file
- Set the sample rate, starting delay, and recording period
- Choose whether to start recording data when the START/ARM button is pushed, or to synchronize the data recording with the RUN button on the main panel

Access

Open the Data Recorder panel by selecting the Data Recorder option from the Operation menu on the main panel.

When to Use the Panel

Use the Data Recorder panel to record data from selected channels and store the data in a file. The data in the file will be in MTS binary format. This data file can be converted to an ascii text format file by choosing the Translate binary to text option under the File menu on the Main panel.

Refer to Appendix A for a list of the available signals.
### Data Recorder (continued)

#### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample Rate</strong> pulldown menu</td>
<td>Select the recording sample rate. The available sample rates are 1, 4, 16, 64, 256, and 1024 Hz.</td>
</tr>
<tr>
<td><strong>Starting delay</strong> text box</td>
<td>Input the time delay between when the Start (or Run) button is pressed and data recording begins.</td>
</tr>
<tr>
<td><strong>Recording period</strong> text box</td>
<td>Input the period of time that the data recorder should run.</td>
</tr>
<tr>
<td><strong>Enable AA Filters</strong> check box</td>
<td>When checked, a digital anti-aliasing filter is added to each selected signal. The software will select an appropriate filter type dependant on the sample rate. The frequency response of this AA filter can be viewed using the FRF panel. The AA filter will add a delay which is displayed for your reference. You may need to adjust the starting delay and/or extend the recording period, accordingly.</td>
</tr>
<tr>
<td><strong>Synchronize with Run</strong> check box</td>
<td>If checked, data recorder will start when the Run button on the main panel is pressed (the Start button on the Data Recorder panel must also be on). If not checked, the data recorder will start as soon as the Start button is pressed.</td>
</tr>
<tr>
<td><strong>Loop Forever</strong> check box</td>
<td>If checked, data recorder will record over and over again.</td>
</tr>
<tr>
<td><strong>File...</strong> button</td>
<td>Input the filename where the recorded data is to be stored.</td>
</tr>
<tr>
<td><strong>Comment</strong> text box</td>
<td>Use this text box to input a comment to be stored with the data. This comment box can be used to input information to identify the particular acquisition such as a Serial ID number, etc.</td>
</tr>
<tr>
<td><strong>Signal Selection</strong> text boxes</td>
<td>Select the signals to be recorded. The Available box shows the available signals. The Selected box shows the selected signals. To move a signal between boxes, first highlight the signal by placing the cursor on it and clicking once on the mouse button. Then click on the appropriate arrow to move the signal to the other box.</td>
</tr>
<tr>
<td><strong>Reset</strong> button</td>
<td>Pressing this button will clear the Selected box of all signals.</td>
</tr>
<tr>
<td><strong>Start/Arm</strong> button</td>
<td>Starts data recording. If acquisition is synchronized, the button will read “Arm” and will gray out after you click on it. Acquisition is then queued to start with the appropriate event.</td>
</tr>
<tr>
<td><strong>Stop</strong> button</td>
<td>Stops data recording. After data acquisition starts, the progress bar grows from left to right, showing how much data has been recorded (0 to 100%).</td>
</tr>
</tbody>
</table>
Digital Meter A or B

Panel Description
The Digital Meter A or B panel allows you to monitor a signal.

Access
Open the Digital Meter A or B panel by selecting the Digital Meter A or Digital Meter B option from the View menu on the main panel.

Toggle the arrow ▸ to display the right side of the display panel as shown below:

When to Use This Panel
Use either panel to read the present voltage value of the selected signal.

Refer to Appendix A for a list of available signals.
**Background Information**

The digital meters provide the following signal monitoring modes:

- **Max/min**

  Monitors the maximum and minimum signal values since the display session began or the reset button was last selected. Signal values are displayed in the Maximum and Minimum text boxes.

- **Peak/valley (banded)**

  Similar to Max/min mode, except the Reset button is automatically pressed after the signal reverses by an amount determined by the sensitivity adjustment. Thus changes in signal peaks and valleys can be continuously monitored. Can be used for cyclic and non-cyclic waveforms.

- **Peak/valley (timed)**

  Similar to Max/min mode, except the Reset button is automatically pressed after the signal reverses a quarter of a cycle as determined by the signal’s current frequency. Thus changes in signal peaks and valleys can be continuously monitored. Can be used only for cyclic waveforms.

- **RMS/mean**

  Monitors the RMS and mean of a signal since the display session began or the reset button was last selected. The amount of signal averaging can be adjusted via the *Averaging Interval* sidebar/textbox. Can be used for cyclic and non-cyclic waveforms.

**Control Descriptions**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Signal** text box | Shows the name of the current selected signal.  
Select a signal using the **Select...**, **Next**, or **Previous** buttons. |
| **Select...** button | Opens the signal selection panel, from which you can select a signal.        |
| **Next** button | Selects the next signal in the selection panel list.                         |
| **Previous** button | Selects the preceding signal in the selection panel list.                    |
**Digital Meter A or B (continued)**

*Control Descriptions*

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum</strong> or <strong>Peak</strong> or <strong>RMS</strong> or <strong>Amplitude</strong> text box</td>
<td>Displays the <strong>Maximum</strong> value for the signal when Capture Mode is Max/Min and Display Mode is Extrema.</td>
</tr>
<tr>
<td></td>
<td>Displays the <strong>Peak</strong> value for the signal when Capture Mode is Peak/valley and Display Mode is Extrema.</td>
</tr>
<tr>
<td></td>
<td>Displays the <strong>RMS</strong> value for the signal when Capture Mode is RMS/Mean (Display Mode is grayed out).</td>
</tr>
<tr>
<td></td>
<td>Displays the <strong>Amplitude</strong> of the signal when Capture Mode is Max/Min or Peak/valley and Display Mode is Amplitude/Base.</td>
</tr>
<tr>
<td><strong>Minimum</strong> or <strong>Valley</strong> or <strong>Mean</strong> or <strong>Base</strong> text box</td>
<td>Displays the <strong>Minimum</strong> value for the signal when Capture Mode is Max/Min and Display mode is Extrema.</td>
</tr>
<tr>
<td></td>
<td>Displays the <strong>Valley</strong> value for the signal when Capture Mode is Peak/valley and Display Mode is Extrema.</td>
</tr>
<tr>
<td></td>
<td>Displays the <strong>Mean</strong> value for the signal when Capture Mode is RMS/Mean. (display Mode is grayed out)</td>
</tr>
<tr>
<td></td>
<td>Displays the <strong>Base</strong> value of the signal when Capture Mode is Max/Min or Peak/valley and Display Mode is Amplitude/Base.</td>
</tr>
<tr>
<td><strong>Current value</strong> text box</td>
<td>Displays the current value of the selected signal.</td>
</tr>
<tr>
<td><strong>Reset</strong> button</td>
<td>Clears the <strong>Minimum</strong> and <strong>Maximum</strong> text boxes.</td>
</tr>
<tr>
<td><strong>arrow</strong></td>
<td>Toggle the <strong>arrow</strong> to open/close the right side of the display panel which contains the options described below.</td>
</tr>
</tbody>
</table>
## Digital Meter A or B (continued)

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Capture Mode</strong></td>
<td>Selects a monitoring mode. The choices are:</td>
</tr>
<tr>
<td></td>
<td>Max/min — display the maximum and minimum values of the signal in the Maximum and Minimum boxes.</td>
</tr>
<tr>
<td></td>
<td>Peak/valley (banded) — display the peak and valley values of a signal determined by reversal outside a specified sensitivity band.</td>
</tr>
<tr>
<td></td>
<td>Peak/valley (timed) – display the peak and valley values of a signal determined by reversal within an amount of time determined by the signal frequency.</td>
</tr>
<tr>
<td></td>
<td>RMS/Mean – display the RMS and mean values of a signal averaged over a specified sliding time interval.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Selects a display mode. The choices are:</td>
</tr>
<tr>
<td></td>
<td>Extrema — Displays min/max or peak/valley values. See Capture mode above.</td>
</tr>
<tr>
<td></td>
<td>Amplitude/Base — Alternative form of displaying extrema, where:</td>
</tr>
<tr>
<td></td>
<td>Amplitude = ( \frac{\text{max} - \text{min}}{2} ) and Base = ( \frac{\text{max} + \text{min}}{2} )</td>
</tr>
<tr>
<td></td>
<td>NOTE: not available in RMS/mean capture mode</td>
</tr>
<tr>
<td><strong>Sensitivity</strong></td>
<td>For peak/valley detection, sets the sensitivity of detection to a percentage of full-scale band. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td><strong>Averaging interval</strong></td>
<td>For RMS/ Mean capture mode, sets the averaging interval. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
</tbody>
</table>
**Digital Readouts**

The Digital Readouts panel allows you to select multiple signals to view their values.

**Access**

Open the Digital Readouts panel by selecting the Digital Readout from the View menu on the main panel.

**When to Use the Panel**

Use this panel to simultaneously view the values of selected signals in engineering units. Refer to Appendix for a list of the available signals.

**Control Descriptions**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numerical</td>
<td>Click near any display box to open a pulldown channel selection box. Select a channel. The selected channel and its value (in engineering units) is displayed.</td>
</tr>
</tbody>
</table>
Encoder Conditioners

Panel Description

The Encoder Conditioners panel allows you to perform the following tasks:
- Select a specific encoder conditioner
- Calibrate the conditioner to its associated transducer
- Select polarity of output
- Select filtering option, baud rate, and sensitivity
- Set hardware limits for the conditioner output (feedback)
- Identify whether an interlock has occurred
- Disable and/or reset interlocks

Access

Open the Encoder Conditioners panel by selecting the Encoder Conditioners option from the Calibration menu on the main panel.

When to Use the Panel

Use the Encoder Conditioners panel to calibrate a conditioner with its associated transducer and to identify and reset hardware interlocks. Whenever a transducer is replaced or moved, the associated conditioner should be calibrated. Hardware limits should be checked and reset before starting a test. In addition, MTS recommends verifying calibration values periodically.

<table>
<thead>
<tr>
<th>Encoder type</th>
<th>Tempsonics III 25-bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud rate</td>
<td>100 kHz</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>0.00061 cts/volt</td>
</tr>
<tr>
<td>Zero</td>
<td>0 cts</td>
</tr>
<tr>
<td>Glitch width</td>
<td>0 samples</td>
</tr>
<tr>
<td>Invert polarity</td>
<td></td>
</tr>
<tr>
<td>Clear count</td>
<td></td>
</tr>
</tbody>
</table>

| Interlocks             |                         |
|                       | ✓ Disabled               |
|                       | ✓ Reset                  |
|                       | ✓ Watchdog timer         |
|                       | ✓ Excitation fail        |
|                       | ✓ Limit                  |

| Engineering Units      |                         |
| +10 volts =            | 10.0 inches             |
| -10 volts =            | -10.0                   |

| Raw output             | 0 counts                |
| Final output           | 0.0 volts               |
|                       | 0.0 volts               |
## Encoder Conditioners (continued)

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cond</strong> text box</td>
<td>Shows the name of the currently selected conditioner. The adjacent conditioner ID box shows the slot number of the selected conditioner. Select a conditioner using the <strong>Select…</strong>, <strong>Next</strong>, or <strong>Previous</strong> buttons.</td>
</tr>
<tr>
<td><strong>Select…</strong> button</td>
<td>Opens the conditioner selection panel, from which you can select a conditioner.</td>
</tr>
<tr>
<td><strong>Next</strong> button</td>
<td>Selects the next conditioner in the selection panel list.</td>
</tr>
<tr>
<td><strong>Previous</strong> button</td>
<td>Selects the preceding conditioner in the selection panel list.</td>
</tr>
<tr>
<td><strong>Encoder Type</strong> pop-up</td>
<td>Displays the type of encoder selected. The choices are:</td>
</tr>
<tr>
<td><strong>Baud rate</strong> button</td>
<td>Sets the baud rate of the excitation signal sent to the encoder. You can use the slide bar to set a value or you can enter it in the text box.</td>
</tr>
<tr>
<td><strong>Sensitivity</strong> text box</td>
<td>Sets the counts/volts.</td>
</tr>
<tr>
<td><strong>Zero</strong> text box</td>
<td>Sets the home position for the encoder.</td>
</tr>
<tr>
<td><strong>Glitch width</strong> text box</td>
<td>Sets the # of samples of dropout expected.</td>
</tr>
</tbody>
</table>

**NOTE:** Output deglitcher: Because this conditioner is often used for conditioning Temposonics transducers which are prone to dropouts and glitches, the output is run through a deglitching filter in the form of a median filter. Set "glitch width" to the number of samples of dropout expected. Setting "glitch width" to zero turns the filter off (default).
### Encoder Conditioners (continued)

#### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invert Polarity</strong> check box</td>
<td>Selects the polarity of the output signal. The choices are: Inverted or noninverted.</td>
</tr>
<tr>
<td>Clear count button</td>
<td>Clears the count.</td>
</tr>
</tbody>
</table>

#### Interlocks

| **Disabled** check box          | When checked, disables hardware interlocks for this channel.                |
| **Reset** button                | When pressed, resets the hardware interlocks for this channel.             |
| **Watchdog timer** indicator    | Indicates the state of the watchdog timer.                                  |
| **Excitation fail** indicator   | Shows whether excitation has failed. This detector is always enabled, both in hardware and software. Excitation failure causes a system interlock because it may indicate a broken, defective or missing conditioner cable. |
| **Limit** indicator             | Indicates whether the conditioner output has gone outside of the limits set using the Upper and Lower Limits slide bars. |

| **Upper Limit** slide bar and text box | Sets the upper limit of the conditioner output. You can use the slide bar to set a value or you can enter it in the text box. If the conditioner output (feedback) has exceeded this limit, the Limit indicator is lit. |
| **Lower Limit** slide bar and text box | Sets the lower limit of the conditioner output. You can use the slide bar to set a value or you can enter it in the text box. If the conditioner output (feedback) has exceeded this limit, the Limit indicator is lit. |

| **Engineering Units** display boxes | Displays the engineering units that equate to ±10 volt. |
| **Raw output value** text button   | Shows the value of the signal output in counts by the selected conditioner. Not editable. |
| **Final output value** text button | Shows the value of the signal output by the selected conditioner. The upper value is in volts, the lower value in engineering units. Not editable. |
FRF Plotter

Panel Description
The FRF (frequency response function) Plotter panel allows you to display the frequency response characteristics of the selected channels. This panel is also used to display the forward FRF determined by the spectrum analyzer. The display plots magnitude or phase vs. frequency.

Access
Open the FRF Plotter panel by selecting the FRF Plotter option from the View menu on the main panel.

When to Use the Panel
Use this panel to display the FRF for one or two channels. It allows you to identify cross coupling between channels. Before using this panel, use the Function Generator panel to set a random drive signal for the channel(s).

Background Information
The frequency response function, or FRF, is a mathematical model that accounts for the effects of a system on a signal.

It provides a linear approximation of the changes in phase and amplitude that occur in the frequencies making up a signal as that signal passes through a system. It is used within a component test to compensate for those changes.

The system that the signal is played through contains the electronic and hydromechanical parts of the testing equipment, the transducers, and the test specimen. The response collected shows all the changes in phase and amplitude that the system produces in the signal. These changes are calculated and used to compensate for the effects of the system on the signal.

If any system component is significantly changed (for example, if a test specimen accelerometer is replaced) a new FRF should be measured for the system.
An FRF is measured by exciting the test system with a shaped random drive signal (whose frequency content is similar to the desired drive signal) and collecting responses to the excitation.

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels select controls</td>
<td>Shows the name of the selected channel.</td>
</tr>
<tr>
<td>FRF A or FRF B text box</td>
<td>Select a channel using the <strong>Select...</strong>, <strong>Next</strong>, or <strong>Previous</strong> buttons.</td>
</tr>
<tr>
<td>Select... button</td>
<td>Opens the channel list box, from which you can select a channel. You can also select a channel by clicking in the appropriate box in the cross-coupling configuration diagram.</td>
</tr>
<tr>
<td>Next button</td>
<td>Selects the next channel in the list.</td>
</tr>
<tr>
<td>Previous button</td>
<td>Selects the preceding channel in the list.</td>
</tr>
</tbody>
</table>
| Magnitude/Phase/Delay pop-up menu | Selects the type of Y-axis data to be displayed. The choices are:  
  - Magnitude (in V/V)  
  - Phase (in degrees)  
  - Delay (in seconds) |
| Reset button                  | Resets the averaging process of the spectrum analyzer. |
| Update button                 | The **Update** button for each signal updates the display to the most current frequency response function. |

**Scale checkboxes:**

- **Auto**
  - Selects independent autoscaling. In this mode, the two signals are scaled to fill the entire display area, regardless of their relation to each other.
  - Even if **Auto** scale is selected, you can change the frequency range of interest using the text boxes on the X axis.

- **Same**
  - If this box is checked, the same scaling is applied to both signals

- **Log**
  - If checked, plots on a logarithmic scale. Unchecked, plots on a linear scale.
### FRF Plotter (continued)

**Control Descriptions (continued)**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Points</strong> text box</td>
<td>Selects and shows the number of points displayed at the selected scale. You can enter a number of points in this box (range 32 to 384).</td>
</tr>
<tr>
<td><strong>Update both</strong> button</td>
<td>The <strong>Update both</strong> button updates the display to the most current frequency response function for both signals.</td>
</tr>
<tr>
<td>Display area text boxes</td>
<td>The text boxes surrounding the display area show the values of the upper and lower ranges currently displayed.</td>
</tr>
<tr>
<td></td>
<td>• The top and bottom text boxes on the right and left sides show the minimum and maximum values of the A and B traces (respectively); the right and left text boxes on the bottom of the monitor show frequency.</td>
</tr>
<tr>
<td></td>
<td>• If you click on a specific point in the display area, a dot appears, and the corresponding X and Y values will be shown in the text boxes in the right center, bottom center, and left center.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click to save plotted values to a text file. A dialog box will appear to ask for a file name.</td>
</tr>
</tbody>
</table>
Function Generators

Cyclic Source

Program: Cyclic
Shape: Square
Peak amplitude: 0.051429 in
Frequency: 5.0 Hz

Phased Source

Program: Phased
Master: Act 2
Shape: Square
Peak amplitude: 0.0 in
Phase: 0.0 deg

Random Source

Program: Random
Shape: Flat
RMS Amplitude: 0.0 in
Minimum freq: 0.0 Hz
Maximum freq: 40.0 Hz

Scramnet

Program: Scramnet
Function Generators (continued)

Remote Application

Data Player File

Pod

Slaving
Function Generators (continued)

**Panel Description**

The Function Generators panel allows you to select the program source and set the appropriate parameters.

The Function Generators panel allows you to perform the following tasks:

- Select a specific channel
- Select the program source for the channel
- Enter the appropriate parameters to define the program output, depending upon the program source selected

**Access**

Open the Function Generator panel by selecting the Function Generators option from the **Operation** menu on the main panel. You can also open this panel by clicking on the **Program Source** icon on the Main panel when Function Generator is selected.

**When to Use the Panel**

You can use this panel to generate and apply a program to any channel of the test system. Typically, you will want to use the function generator when you are tuning the servo control loops during test setup, but it can also be used for testing.

**Important Information**

⚠️ **WARNING**

Whenver hydraulic pressure is applied, adjustment of the controls on the Function Generators panel can cause actuator movement.

Unexpected actuator movement can result in personal injury or equipment damage.

Ensure that all personnel are clear of the actuators, fixturing, and specimen before adjusting any Function Generators control. In addition, make sure that all operators know the effect of control adjustments before they make any adjustments.
## Function Generators (continued)

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Controls for all sources:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Chan</strong> text box</td>
<td>Shows the name of the currently selected channel. The adjacent channel ID box shows the number of the selected channel. Select a channel using the <strong>Select...</strong>, <strong>Next</strong>, or <strong>Previous</strong> buttons.</td>
</tr>
<tr>
<td><strong>Select...</strong> button</td>
<td>Opens the channel selection panel, from which you can select a channel.</td>
</tr>
<tr>
<td><strong>Next</strong> button</td>
<td>Selects the next channel in the selection panel list.</td>
</tr>
<tr>
<td><strong>Previous</strong> button</td>
<td>Selects the preceding channel in the selection panel list.</td>
</tr>
<tr>
<td><strong>Program</strong> pop-up menu</td>
<td>Selects the programming source for the channel. The choices are:</td>
</tr>
<tr>
<td></td>
<td><em>Cyclic</em>  <em>Slaving</em></td>
</tr>
<tr>
<td></td>
<td><em>Phased</em>   <em>Scramnet</em></td>
</tr>
<tr>
<td></td>
<td><em>Random</em>   <em>Remote Application</em></td>
</tr>
<tr>
<td></td>
<td><em>Pod</em> <em>Data Player File</em></td>
</tr>
<tr>
<td></td>
<td><em>These options are available only to users with extended access.</em></td>
</tr>
</tbody>
</table>

**NOTE** If the main panel buttons for Remote Application, Data Player, Scramnet, or Pod are selected, all function generators are set to that same source. This menu is then grayed out and cannot be changed.
## Function Generators (continued)

### Control Descriptions (for Cyclic Program)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Controls for Cyclic source:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Shape radio buttons</strong></td>
<td>Selects the shape of the function to be generated for the selected channel by the <em>cyclic</em> function generator.</td>
</tr>
<tr>
<td><em>(Square, Triangle, Sine)</em></td>
<td></td>
</tr>
<tr>
<td><strong>Peak amplitude</strong></td>
<td>Sets the peak amplitude of the function to be generated for the selected channel by the <em>cyclic</em> function generator. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
<td>Sets the frequency of the function to be generated for the selected channel by the <em>cyclic</em> function generator. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
</tbody>
</table>

### Control Descriptions (for Random Program)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Controls for Random source:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Shape pop-up menu</strong></td>
<td>Selects the shape of the function to be generated for the selected channel by the <em>random</em> function generator. The choices are:</td>
</tr>
<tr>
<td></td>
<td>1/F^2</td>
</tr>
<tr>
<td></td>
<td>1/F</td>
</tr>
<tr>
<td></td>
<td>Flat</td>
</tr>
<tr>
<td></td>
<td>F</td>
</tr>
<tr>
<td></td>
<td>F^2</td>
</tr>
<tr>
<td><strong>RMS Amplitude</strong></td>
<td>Selects the root mean square amplitude for the function to be generated for the selected channel by the <em>random</em> function generator. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Minimum freq</strong></td>
<td>Selects the minimum frequency content for the signal to be generated for the selected channel by the <em>random</em> function generator. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Maximum freq</strong></td>
<td>Selects the maximum frequency content for the signal to be generated for the selected channel by the <em>random</em> function generator. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
</tbody>
</table>
## Function Generators (continued)

### Control Descriptions (for Phased Program)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Controls for Phased channel source:</strong></td>
<td>NOTE: This can be considered a master/slave channel relationship. This source can only be selected if the master channel has a cyclic source. The master channel determines the frequency. The shape, amplitude and phase lag between the master/slave channels is selectable.</td>
</tr>
<tr>
<td><strong>Master pop-up menu</strong></td>
<td>Selects the master actuator.</td>
</tr>
<tr>
<td><strong>Shape radio buttons (Sine)</strong></td>
<td>Selects the shape of the function to be generated for the slave channel.</td>
</tr>
<tr>
<td><strong>Peak amplitude slide bar and text box</strong></td>
<td>Sets the peak amplitude of the function to be generated for the slave channel. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Phase slide bar and text box</strong></td>
<td>Sets the phase lag between the master channel and the slave channel. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
</tbody>
</table>

### Control Descriptions (for Others)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Controls for Slaving source:</strong></td>
<td>NOTE: The following controls are not selectable via the Function Generator panel. They are for display purposes only and are selected via the Main panel.</td>
</tr>
<tr>
<td><strong>Controls for Remote Application source:</strong></td>
<td>This option indicates that the program command to the selected actuator is the command at the bottom of the Slaving Matrix panel. Refer to the Slaving Matrix panel information.</td>
</tr>
<tr>
<td><strong>Controls for Data Player File source:</strong></td>
<td>This option indicates that the program command to the selected actuator comes from playing an external data file. Refer to Data Player panel information.</td>
</tr>
<tr>
<td><strong>Controls for Pod source:</strong></td>
<td>This option indicates that the program command is set by the remote control pod. The only available commands are setpoint and control mode. Refer to Section 6, Remote Control Pendant Operation.</td>
</tr>
<tr>
<td><strong>Controls for Scramnet source:</strong></td>
<td>NOTE: While Pod is the program source, dynamic commands cannot be run. This option indicates that the program command is generated from Scramnet.</td>
</tr>
</tbody>
</table>
**Limit Detectors**

---

**Panel Description**

The Limit Detector panel allows you to:

- Select a specific software signal for which a limit can be set
- Choose the action to be taken if a limit is exceeded
- Set an allowable operating range and persistence value for the signal
- Identify if an upper or lower out-of-limit has occurred
- Reset the software limit detector circuit

---

**Access**

Open the Limit Detector panel by selecting the Limit Detectors option from the **Operation** menu on the main panel. You can also open this panel by clicking on the **Interlocks** icon on the Main panel.

---

**When to Use the Panel**

Use the panel to set safety limits for the test system during test specification. This panel can be used to set software limits for the following signals:

- Actuator displacement feedback
- Actuator displacement error
- Actuator force feedback
- Actuator force error
- User A/D
- User DUCs
- User Encoders

Each of the above signals have 2 detectors designated A and B.
Limit Detectors (continued)

Important Information

The limit detectors are designed to protect equipment from damage. They are not designed, and should not be used, to protect personnel from injury.

The limit detectors are enabled and disabled from the main panel. If not enabled, they will not set an indicator or interlock.

Background Information

A limit event for a particular signal indicates that the signal has exceeded its upper or lower limit. The upper and lower limits establish a range of values that represent a desired system operating range. This band also represents the range where valid test data can be ensured. The persistence value is a time (in seconds) that an upper or lower out-of-limit condition can persist without causing an interlock.

When an out-of-limit condition occurs, the Message Log panel identifies the specific out-of-limit condition.

Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Det text box</td>
<td>Shows the name of the current selected signal. Select a signal using the Select..., Next, or Previous buttons.</td>
</tr>
<tr>
<td>Select... button</td>
<td>Opens the signal selection panel, from which you can select a signal.</td>
</tr>
<tr>
<td>Next button</td>
<td>Selects the next signal in the selection panel list.</td>
</tr>
<tr>
<td>Previous button</td>
<td>Selects the preceding signal in the selection panel list.</td>
</tr>
<tr>
<td>Reset button</td>
<td>When pressed, clears the Upper and Lower indicators and any software interlocks generated by the out-of-limit condition, if the channel is within limits.</td>
</tr>
</tbody>
</table>
Limit Detectors (continued)

Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action pop-up menu</td>
<td>Select the result of an out-of-limit condition. Selections are:</td>
</tr>
<tr>
<td></td>
<td>• Indicate – This selection causes the indicator to light only while the signal is outside of the limit. When the signal returns inside the limit, the indicator goes out.</td>
</tr>
<tr>
<td></td>
<td>• Alert – This selection causes the indicator to light and latch. When the signal returns inside the limit, the indicator remains lit until the Reset button is used. The out-of-limit condition will be recorded in the message log.</td>
</tr>
<tr>
<td></td>
<td>• Pause – This selection causes the indicator to light and latch, and the system will hold the current controller commands as they were when the signal violated the limit. When the signal returns inside the limit, the Pause button can be used to resume the signal from where it left off, the indicator remains lit until the Reset button is used. The out-of-limit condition will be recorded in the message log.</td>
</tr>
<tr>
<td></td>
<td>• Program abort– This selection causes the system to trigger an abort if the signal goes outside the limit. The Reset button is required to reset the system. The out-of-limit condition will be recorded in the message log.</td>
</tr>
<tr>
<td></td>
<td>• Abort &amp; switch to displ– This selection causes the system to trigger an Abort if the signal goes outside the limit. If the system is in force control, it will switch to displacement control. The Reset button is required to reset the system. The out-of-limit condition will be recorded in the message log.</td>
</tr>
<tr>
<td></td>
<td>• Interlock – This selection causes the system to trigger an Emergency Stop if the signal goes outside the limit. The Reset button is required to reset the system. The out-of-limit condition will be recorded in the message log.</td>
</tr>
</tbody>
</table>

NOTE the following definitions:

Pause - allows user to pause the program while hydraulic service manifold is open. Motion is temporarily halted. Clicking on the Pause button again will resume motion. The program runs without commands being sent to the servo controller.

Abort - aborts the test program. Motion is halted, setpoints are updated to current feedback levels, and span is zeroed.
## Limit Detectors (continued)

### Control Descriptions (continued)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Upper</strong> slide bar and text box</td>
<td>Sets the upper limit of the selected signal. Note that when you set the upper limit value, the lower limit is automatically set to the negative of the upper limit value. If you desire a different lower limit value, you should change it using the lower slide bar after setting the upper limit.</td>
</tr>
<tr>
<td><strong>Upper</strong> indicator</td>
<td>Lights when an out-of-limit condition occurs for the upper limit.</td>
</tr>
<tr>
<td><strong>Lower</strong> slide bar and text box</td>
<td>Sets the lower limit of the selected signal. Setting this value does not affect the upper limit value.</td>
</tr>
<tr>
<td><strong>Lower</strong> indicator</td>
<td>Lights when an out-of-limit condition occurs for the lower limit.</td>
</tr>
<tr>
<td><strong>Persistence</strong> slide bar and text box</td>
<td>Sets the time, in seconds, that an upper or lower out-of-limit condition can persist without causing an interlock.</td>
</tr>
</tbody>
</table>
Main Panel

The main panel allows access to all other parts of the Structural Test System application. It includes both menus and system controls. The following menus are provided:

- **File**—allows you to add comments to the message log, change passwords for access privileges, close windows, restore or save settings, convert files from binary to text format or visa versa, and quit the application.

- **Calibration**—allows you to calibrate A/D and D/A converters, AC and DC conditioners, and valve drivers.

- **Configuration**—allows you to configure testpoint units, slaving matrix, and ramp rates.

- **Operation**—allows you to setup PID controllers, function generators, data players, data recorders, limit detectors, setpoints and spectrum analyzers.

- **Display**—allows you to use analog and digital readouts, digital meters, FRF plotters, the digital oscilloscope and read the message log.

Note that you can click on an underlined icon on the main panel to open the associated panel for that item.
Main Panel (continued)

System controls on the main panel allow you to perform the following tasks:

• Monitor the current settings file
• Monitor hydraulics
• Enable or disable limits
• Reset limit/interlock conditions
• Select the program source
• Set the master gain
• Set the desired span and monitor current span
• Stop, run, pause or abort a program
• Indicate if the pod is ready
• Indicate if scramnet is OK

Access

The main panel opens when you start the application. It cannot be closed except by quitting the application.

When to Use the Panel

Use this panel to set system controls and to access all other panels.

Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hydraulics</strong></td>
<td></td>
</tr>
<tr>
<td><strong>HPS On</strong> status indicator</td>
<td>The status indicator will turn green when the pumps reach the system</td>
</tr>
<tr>
<td></td>
<td>operating pressure.</td>
</tr>
<tr>
<td><strong>HSM 1-9</strong> buttons</td>
<td>Selects the hydraulic service manifolds that will turn on when the</td>
</tr>
<tr>
<td></td>
<td><strong>HSM Lo</strong> button is enabled.</td>
</tr>
<tr>
<td><strong>HSM Lo</strong> button and status</td>
<td>Puts the HSM into low pressure mode. The status indicator will turn</td>
</tr>
<tr>
<td>indicator</td>
<td>yellow when low pressure is achieved.</td>
</tr>
<tr>
<td><strong>HSM Hi</strong> button and status</td>
<td>Puts the HSM into high pressure mode. The status indicator will turn</td>
</tr>
<tr>
<td>indicator</td>
<td>green when the system is in high pressure mode.</td>
</tr>
</tbody>
</table>
### Main Panel (continued)

#### Control Descriptions (continued)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interlocks</strong> pop-up menu</td>
<td>Enables/disables the software and hardware limit detectors. The hardware limit detectors are only enabled if the “hardware limits” disable control is not checked on the AC/DC Conditioner panels.</td>
</tr>
<tr>
<td><strong>Interlocks</strong> indicator and <strong>Reset</strong> button</td>
<td>Indicates whether a system interlock condition exits. Use the <strong>Reset</strong> button to clear the hardware and software limit status indicators located on the AC/DC Conditioner, Encoder Conditioner, and Limit Detector panels and the E-STOP chain.</td>
</tr>
</tbody>
</table>
| **Program Source** radio buttons | Select the desired program source.  
Function Generator – setup function using Function Generator panel  
Data Player File – select file using Data Player panel  
Remote Application – select to enable a program source from a remote application via TCP/IP  
Scramnet – input external digital signal from Scramnet  
Pod – input external analog signal |
| **Enable simulation** check box  | When checked, allows the user to rehearse or simulate how the system will perform. Hydraulics will not be enabled, but real time controller will function as if the system is real. |
| **Bypass Controllers** check box | When checked, allows the user to bypass the controllers. User must provide a controller via Scramnet and Simulink.  
NOTE: If checked, user is responsible for command generation and servo control. |
| **Pod Ready** indicator          | Indicates if the remote control pod is ready.                                                                                                                                                                |
| **Scramnet OK** indicator        | Indicates that Scramnet is connected and functioning properly.                                                                                                                                               |
| **Master Gain** slide bar and text box | Adjusts the master gain. You can use the slide bar to set a value or enter it in the text box.                                                                                                             |
| **Desired span** slide bar and text box | Adjusts the desired span of the command signal. You can use the slide bar to set a value or enter it in the text box.                                                                                          |
| **Current span** display         | Shows the current value of the span. The master span may take time to ramp up to its set value. This shows the actual value, at any moment.                                                               |
### Control Descriptions (continued)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Stop/Run/Pause/Abort buttons** | Controls the program.  
  
  **Stop** - stops the test program. Span will ramp to zero. System returns to setpoint levels  
  
  **Run** - enables and runs the program.  
  
  **Pause** - allows user to pause the program while hydraulic service manifold is open. Motion is temporarily halted. Clicking on the Pause button again will resume motion. The program runs without commands being sent to the servo controller.  
  
  **Abort** - aborts the test program. Motion is halted, setpoints are updated to current feedback levels, and span is zeroed. |
Message Log

Panel Description
The Message Log panel allows you to read messages generated by system events. Messages are saved to a file called `message.txt`. This file records many system actions automatically.

Access
Open the Message Log panel by selecting the Message Log option from the View menu on the main panel.

In this view, the message log can be read but not changed. To add data to the message log, use the Add comment... option on the File menu.

When to Use the Panel
Use this panel to read the message log. Only messages from the current session are displayed. The file `message.txt`, however, keeps a running list of all messages from all sessions.

Editing the Log
The file `message.txt` continues to grow, recording events from session to session. It may grow too large and unwieldy. You can quit the application and rename it. The application will then create a new `message.txt` file next time you start up.

NOTE
This file must periodically be cleaned up to prevent it from growing large and affecting performance.

Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll bar</td>
<td>Use the scroll bar to scroll through messages in the message log.</td>
</tr>
</tbody>
</table>
Panel Description

The Oscilloscope panel shows oscilloscope traces for one or two signals. This panel allows you to perform the following tasks:

- Select one or two signals to be monitored.
- Set the sweep period and delay for the display of the selected signals.
- Select the scaling mode of the selected signals.
- Select the display mode for the monitor.
- Select the sweep mode for the monitor.

Access

Open the Oscilloscope panel by selecting the Oscilloscope option from the View menu on the main panel.

When to Use the Panel

Use this panel at any time to monitor system signals.

Refer to Appendix A for a list of available signals.
### Oscilloscope (continued)

#### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels select controls</td>
<td>Shows the name of the currently selected signal.</td>
</tr>
<tr>
<td><strong>Ch A or Ch B text box</strong></td>
<td>Select a signal using the <strong>Select...</strong>, <strong>Next</strong>, or <strong>Previous</strong> buttons. You can select NONE from the <strong>Select...</strong> list (or a blank from <strong>Next</strong> or <strong>Previous</strong>) to remove a channel from the display.</td>
</tr>
<tr>
<td><strong>Select... button</strong></td>
<td>Opens the signal selection list, from which you can select a signal.</td>
</tr>
<tr>
<td><strong>Next</strong> button</td>
<td>Selects the next signal in the list.</td>
</tr>
<tr>
<td><strong>Previous</strong> button</td>
<td>Selects the preceding signal in the list.</td>
</tr>
<tr>
<td><strong>Sweep Period</strong> slide bar and text box</td>
<td>Sets the sweep period in seconds, for a trace on the oscilloscope display. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>A–B Delay</strong> slide bar and text box</td>
<td>Sets the time by which the Channel B trace follows the Channel A trace. (If the value is negative, B precedes A.) You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Autoscale</strong> check box</td>
<td>Selects independent autoscaling. In this mode, the two signals are scaled to fill the entire scope display area, regardless of their relation to each other.</td>
</tr>
<tr>
<td><strong>Same scale</strong> check box</td>
<td>If this box is checked, the same scaling is applied to both signals.</td>
</tr>
<tr>
<td><strong>Display mode</strong> radio buttons</td>
<td>Select a relation for the A and B traces:  \n</td>
</tr>
</tbody>
</table>
### Oscilloscope (continued)

**Control Descriptions (continued)**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sweep Single and Auto buttons</strong></td>
<td>Select single sweep or automatically updated sweeps for display.</td>
</tr>
<tr>
<td></td>
<td>• If in <strong>Single</strong> mode, only one sweep will be displayed. To update the display, use the <strong>Single</strong> button again.</td>
</tr>
<tr>
<td></td>
<td>• If in <strong>Auto</strong> mode, the display will be updated when one sweep period (as set on the <strong>Sweep Period</strong> slide bar) of new data is available.</td>
</tr>
<tr>
<td></td>
<td>To return to the single mode from the automatic mode, use either the <strong>Single</strong> or <strong>Auto</strong> button.</td>
</tr>
<tr>
<td><strong>Scope display area text boxes</strong></td>
<td>The text boxes surrounding the scope display area show the values of the upper and lower limits currently displayed.</td>
</tr>
<tr>
<td></td>
<td>• If in <strong>Time</strong> display mode, the top and bottom text boxes on the right and left sides show the minimum and maximum values of the A and B traces (respectively); the right and left text boxes on the bottom of the monitor show time.</td>
</tr>
<tr>
<td></td>
<td>• If in <strong>Freq</strong> display mode, the top and bottom text boxes on the right and left sides show the minimum and maximum values of the A and B traces (respectively); the right and left text boxes on the bottom of the monitor show frequency.</td>
</tr>
<tr>
<td></td>
<td>If in <strong>X-Y</strong> display mode, values of A and B are shown on the left and bottom (respectively), and nothing is displayed in the text boxes on the right.</td>
</tr>
<tr>
<td></td>
<td>• If you click on a specific point in the scope display area, a line appears, and the corresponding X and Y values will be shown in the text boxes in the right center, bottom center, and left center.</td>
</tr>
</tbody>
</table>
PID Controllers

Panel Description
The PID Controllers panel allows you to set up and tune the PID servo control loops.

Access
Open the PID Controllers panel by selecting the Controllers option from the Operation menu on the main panel.

When to Use the Panel
You can use the PID Controllers panel to set up or adjust parameters for a PIDF controller, including the following:
- Gain (P)
- Reset (I)
- Rate (D)
- Integ Authority
- Bandwidth
- Delta P

Control Panel Reference
Before making any adjustments, you may wish to use the »Copy» command to copy the current stable settings to the reference gains. If the system then becomes unstable, you can immediately click on the <<COPY button and restore the stable setting to current gains. You can also switch between reference and current gains via the <<Switch>> button for quick comparisons.

**Background Information**

Each of the controls on the PID Controllers panel affects the system in a distinct way. It is important to understand these effects before attempting to tune the system.

**Servo Controller Error**

The servo control process sums feedback and command signals to generate an error signal, which is sent to the valve driver to generate the servovalve control signal.

The command and (conditioned) feedback signals are summed to create an initial error signal. That signal is gain-adjusted and summed with integral and derivative factors before a bandwidth adjustment is made to the signal. The resulting error signal is sent to the valve driver (or valve controller).

The servo loop adjustments establish the response and stability of the servo control loop. Servo loop adjustments are experimental and you should become familiar with the effects of these adjustments while using dummy specimens during both dynamic and static system operation.

Because each adjustment can have some effect on the other adjustments, adjustments to the servo loop should be made iteratively.

The following paragraphs explain how the servo loop controls affect the error signal.

**Proportional Gain**

Proportional gain adjustments affect how well the error signal will follow the program. The greater the proportional gain, the more the servovalve opens for a given error. As proportional gain is increased, the error decreases, indicating closer tracking of the feedback to the command. The following figure illustrates the program and resulting transducer feedback signal with a small proportional gain.
PID Controllers (continued)

Increasing the gain decreases the stability margin of the system, increases the frequency of oscillation, and decreases response time. The following figure illustrates the effect that increasing the proportional gain has on the transducer feedback.

If the proportional gain is set too high, unstable system operation and "ringing" can result. This instability may cause specimen damage. Consequently, proportional gain should be set as high as possible while maintaining stable system operation.

*Integral*

Integral adjustments affect system accuracy during static or low-frequency operation when the actuator cannot keep the commanded position. Increasing the Integral adjustment reduces the error between command and feedback by integrating out offsets in the dc portion of the feedback.

Because the integrator can integrate to large or even infinite values, a limit is placed on how much correction the integrator can apply. This limit is called “Integrator Authority”.

---

5-46   Control Panel Reference
Feedforward

Feedforward effectively alters loop response by introducing a derivative of the command signal. The feedforward component is used to minimize following errors or phase lag. It is especially useful because it does not affect the control loop stability. As illustrated, higher settings reduce following error during a ramp command, ultimately producing a leading error.

Derivative

Derivative adjustments affect the servo control loop dynamic stability. You can use derivative to reduce overshoot at higher proportional gain settings. In addition, it can reduce the system bandwidth, closing the servovalve in anticipation of achieving the commanded position through the rate of change in feedback. The following figure shows the effect of adding derivative to a transducer feedback signal that has already been adjusted for proportional gain.

Bandwidth

The bandwidth adjustment is used to filter the drive signal to the servovalve and can be used to remove frequency content that can make the system become unstable.

Delta P

Used to provide damping of the oil column spring.
### PID Controllers (continued)

#### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Channel</strong> text box</td>
<td>Shows the name of the current selected signal.</td>
</tr>
<tr>
<td></td>
<td>Select a signal using the Select..., Next, or Previous buttons.</td>
</tr>
<tr>
<td><strong>Select...</strong> button</td>
<td>Opens the signal selection panel, from which you can select a signal.</td>
</tr>
<tr>
<td><strong>Next</strong> button</td>
<td>Selects the next signal in the selection panel list.</td>
</tr>
<tr>
<td><strong>Previous</strong> button</td>
<td>Selects the preceding signal in the selection panel list.</td>
</tr>
<tr>
<td><strong>Apply</strong> button</td>
<td>Pressing this button will apply the controller settings on this panel to</td>
</tr>
<tr>
<td></td>
<td>selected modules.</td>
</tr>
<tr>
<td><strong>Current gains</strong> and</td>
<td>A gain parameter can be entered as Current gains, which go into effect</td>
</tr>
<tr>
<td><strong>Reference gains</strong></td>
<td>immediately. Current gains can be copied to Reference gains, which</td>
</tr>
<tr>
<td></td>
<td>are kept in memory but not used. The &lt;&lt;Copy&lt;&lt;, &lt;&lt;Switch&gt;&gt; and</td>
</tr>
<tr>
<td></td>
<td>&gt;&gt;Copy&gt;&gt; buttons are used to move the complete set of gain parameters</td>
</tr>
<tr>
<td></td>
<td>between Current and Reference.</td>
</tr>
<tr>
<td><strong>&gt;&gt;Copy&gt;&gt;</strong></td>
<td>Copies all current gain parameters to their corresponding reference gains.</td>
</tr>
<tr>
<td><strong>&lt;&lt;Switch&gt;&gt;</strong></td>
<td>Swaps all current gain parameters with their corresponding reference gains.</td>
</tr>
<tr>
<td><strong>&lt;&lt;Copy&gt;&gt;</strong></td>
<td>Copies all reference gain parameters to their corresponding current gains.</td>
</tr>
<tr>
<td><strong>Proportional</strong> slide</td>
<td>Adjusts the gain value. You can use the slide bar to set a value or enter</td>
</tr>
<tr>
<td>bar and text box</td>
<td>it in the text box.</td>
</tr>
<tr>
<td><strong>Integral</strong> slide bar</td>
<td>Adjusts the reset value. You can use the slide bar to set a value or enter</td>
</tr>
<tr>
<td>and text box</td>
<td>it in the text box.</td>
</tr>
<tr>
<td><strong>Integral indicator</strong></td>
<td>Indicates the state of the reset integrator.</td>
</tr>
<tr>
<td></td>
<td>White – not integrating</td>
</tr>
<tr>
<td></td>
<td>Green – integrating</td>
</tr>
<tr>
<td></td>
<td>Red – has integrated up to maximum integral authority. You should review</td>
</tr>
<tr>
<td></td>
<td>whether to increase the integral authority.</td>
</tr>
<tr>
<td><strong>Integ Authority</strong> slide</td>
<td>Adjusts the limit for the reset integrator control authority. Input the</td>
</tr>
<tr>
<td>bar and text box</td>
<td>value in % of full-scale output. You can use the slide bar to set a value</td>
</tr>
<tr>
<td></td>
<td>or enter it in the text box.</td>
</tr>
</tbody>
</table>
## PID Controllers (continued)

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Derivative</strong> slide bar and text box</td>
<td>Adjusts the rate value. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Feedforward</strong> slide bar and text box</td>
<td>Adjusts the amount of the differentiated program signal summed with gain, reset, and rate to create the valve command signal for the selected channel. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Bandwidth</strong> slide bar and text box</td>
<td>Adjusts the bandwidth of the low pass filter. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Delta-P</strong> slide bar and text box</td>
<td>Adjusts the amount of delta pressure that is summed with gain, reset, and rate to create the command signal. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
</tbody>
</table>
Ramp Rates

**Panel Description**
The Ramp Rates panel allows you to set maximum values for the setpoint generator velocity and acceleration, the span run, stop, frequency, and phase rates.

**Access**
Open the Ramp Rates panel by selecting the Ramp Rates option from the Configuration menu on the main panel.

**When to Use the Panel**
Use this panel to set limits on how fast the system can reach the displacement or force setpoint and how fast it can ramp up or down. Note that these values are % of full scale, not engineering units.

**Control Descriptions**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal text box</td>
<td>Shows the name of the current selected signal.</td>
</tr>
<tr>
<td>Select... button</td>
<td>Select a signal using the Select..., Next, or Previous buttons.</td>
</tr>
<tr>
<td>Next button</td>
<td>Selects the next signal in the selection panel list.</td>
</tr>
<tr>
<td>Previous button</td>
<td>Selects the preceding signal in the selection panel list.</td>
</tr>
<tr>
<td>Setpoint rate</td>
<td>Input the maximum velocity that the system is allowed to achieve while trying to reach the displacement or force setpoint value set on the Setpoints panel.</td>
</tr>
</tbody>
</table>
## Ramp Rates (continued)

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Run span rate</strong></td>
<td>Input the maximum rate that the span function generator is allowed to ramp up when starting a program</td>
</tr>
<tr>
<td><strong>Stop span rate</strong></td>
<td>Input the maximum rate that the span function generator is allowed to ramp down when stopping a program.</td>
</tr>
<tr>
<td><strong>Frequency rate</strong></td>
<td>Input the maximum rate that the program will ramp to a new frequency when the program cyclic generator frequency is abruptly changed.</td>
</tr>
<tr>
<td><strong>Phase rate</strong></td>
<td>Input the rate that the phase lag between a master and slave channel can be changed.</td>
</tr>
</tbody>
</table>
Setpoints (continued)

**Panel Description**

The Setpoints panel allows you to define a desired position or force setpoint for each actuator.

**Access**

Open the Setpoints panel by selecting the Setpoints option from the Operation menu on the main panel.

**When to Use the Panel**

Use this panel to define a desired position or force setpoint for each actuator. The software will move the actuator to this position or load the structure to the desired force when power is applied to the actuator and the Run button is pressed on the Main panel.

**Control Descriptions**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Act 1-8 radio buttons</td>
<td>Selects the control mode for a specific actuator.</td>
</tr>
<tr>
<td>Act 1-8 Displ text boxes</td>
<td>In displacement mode, inputs desired displacement.</td>
</tr>
<tr>
<td>Act 1-8 Displ text boxes</td>
<td>If you change from force mode to displacement mode, displays current position feedback. The software reads the current displacement feedback and automatically sets the displacement setpoint to that value, and transfers authority to the force feedback control loop.</td>
</tr>
<tr>
<td>Act 1-8 Force text boxes</td>
<td>In force mode, inputs desired force.</td>
</tr>
<tr>
<td>Act 1-8 Force text boxes</td>
<td>If you change from displacement mode to force mode, displays current force feedback. The software reads the current force feedback, and automatically sets the force setpoint to that value, and transfers authority to the force feedback control loop.</td>
</tr>
</tbody>
</table>
**Slaving Matrix**

**Panel Description**

The Slaving Matrix panel allows you to create a command to an actuator that is a linear combination of other system feedbacks. This allows slaving the motion of an actuator to the motion of another.

**Access**

Open the Slaving Matrix panel by selecting the Slaving Matrix option from the **Configuration** menu on the main panel.

**When to Use the Panel**

Use this panel to use any linear combination of feedback signals to create an actuator command.
## Slaving Matrix (continued)

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Values</strong> display boxes</td>
<td>Click on near any <em>Values</em> display box to open a signal selection box. Select a signal. Displays the selected signal value.</td>
</tr>
<tr>
<td><strong>Tare Offsets</strong> text boxes</td>
<td>Input value to be subtracted from the “Values” textbox. This result for a given feedback signal will be multiplied by the value in the corresponding “Coefficient” textboxes.</td>
</tr>
<tr>
<td>![Button]</td>
<td>If you click on the button, the tare offsets value will set to the current feedback value. This allows a given feedback signal to have no effect on the outputs. You can edit the Tare Offset values by manual text entry.</td>
</tr>
</tbody>
</table>
| **Coefficients** textboxes | Inputs coefficients for the slaving matrix. The slaving matrix multiplies a vector (the difference between feedback values and tare offsets). The result of this product becomes the actuator commands. The \((i,j)\)th element multiplies the \(i\)th feedback signal to sum towards the \(j\)th actuators command as shown in the formula below.  
\[
\text{Slave Command}_j = \sum_{i=1}^{n} \text{Coefficient}_{i,j} \times (\text{Input}_i - \text{Tare Offset}_i)
\]
| **Outputs** display boxes | Displays the command signal for the appropriate actuator. |
Spectrum Analyzer

The Spectrum Analyzer panel allows you to set up the spectrum analyzer to measure the forward transfer function between two channels. Use the FRF Plotter panel to display the transfer functions.

Access
Open the Spectrum Analyzer panel by selecting the Spectrum Analyzer option from the Operation menu on the main panel.

When to Use the Panel
Use the Spectrum Analyzer when tuning the system to monitor signals for frequency content and to check for system resonances.

The Spectrum Analyzer produces a true FFT transfer function with input and output PSDs and coherence functions. It uses Hanning windows, 50% frame overlaps, and exponential averaging to minimize leakage effects and to smooth spectral estimates.
## Spectrum Analyzer (continued)

### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input and Output</strong> text</td>
<td>Shows the name of the selected input channel.</td>
</tr>
<tr>
<td>boxes</td>
<td>Select a channel using the Select…, Next, or Previous buttons.</td>
</tr>
<tr>
<td><strong>Select… button</strong></td>
<td>Opens the channel list box, from which you can select a channel.</td>
</tr>
<tr>
<td><strong>Next button</strong></td>
<td>Selects the next channel in the list.</td>
</tr>
<tr>
<td><strong>Previous button</strong></td>
<td>Selects the preceding channel in the list.</td>
</tr>
<tr>
<td><strong>Enable button</strong></td>
<td>Use to enable/disable the spectrum analyzer.</td>
</tr>
<tr>
<td><strong>Remove mean check box</strong></td>
<td>When checked, removes the dc content of the signal by adding a high-pass filter (with an extremely low cut-in frequency) to the input of the analyzer.</td>
</tr>
<tr>
<td><strong>Difference output check box</strong></td>
<td>When checked, the software will differentiate the output signal to remove any integrator between the input and output.</td>
</tr>
<tr>
<td><strong>Sample rate selection box</strong></td>
<td>Use to select the desired sample rate of the spectrum analyzer.</td>
</tr>
<tr>
<td><strong>FFT size selection box</strong></td>
<td>Use to select the FFT size. The FFT size determines the frequency resolution of the analyzer (Resolution = 1K Hz ÷ FFT size).</td>
</tr>
<tr>
<td><strong>Decay time constant slide bar and text box</strong></td>
<td>Use to adjust the decay time constant which determines how long the analyzer keeps data before discounting it. A lower average will allow the analyzer to track better but the signals will be noisier.</td>
</tr>
<tr>
<td><strong>Averages taken display box</strong></td>
<td>Displays how many averages have been taken by the analyzer. Can be reset to zero using the Reset button.</td>
</tr>
<tr>
<td><strong>Reset button</strong></td>
<td>Resets the Averages taken to zero.</td>
</tr>
</tbody>
</table>
Testpoint Units

Panel Description
Allows you to set engineering units for testpoints in the software. NOTE: If the testpoint is a feedback signal, the units of the associated converter will not change.

Access
Open the Testpoint Units panel by selecting the Testpoint Units option from the Configuration menu on the main panel.

When to Use the Panel
Use this panel when viewing signals in analog form, allowing the conversion to digital units. Maximum value corresponds to +10 Volts and Minimum value corresponds to −10 Volts.

Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel text box</td>
<td>Shows the name of the current selected channel.</td>
</tr>
<tr>
<td></td>
<td>Select a channel using the Select..., Next, or Previous buttons.</td>
</tr>
<tr>
<td>Select... button</td>
<td>Opens the channel selection panel, from which you can select a channel.</td>
</tr>
<tr>
<td>Next button</td>
<td>Selects the next channel in the selection panel list.</td>
</tr>
<tr>
<td>Previous button</td>
<td>Selects the preceding channel in the selection panel list.</td>
</tr>
<tr>
<td>Maximum display box</td>
<td>Displays the maximum engineering value of the selected analog signal as viewed as a testpoint.</td>
</tr>
<tr>
<td>Minimum display box</td>
<td>Displays the minimum engineering value of the selected analog signal as viewed as a testpoint.</td>
</tr>
</tbody>
</table>
3-Stage Valve Drivers

Panel Description

For three-stage valves, the Valve Drivers panel allows you to perform the following tasks:

- Select a specific valve driver channels
- Adjust the dither amplitude and balance for the selected valve driver channel
- View the value input to the valve driver by the servocontroller
- Insert the valve phase
- Disable and/or reset interlocks
- Monitor interlocks
- Tune the inner loop
- Make spool conditioner adjustments

Access

Open the Valve Drivers panel by selecting the 3-Stg Valve Drivers option from the Calibration menu on the main panel.

When to Use the Panel

Use the Valve Drivers panel when adjusting the valve balance and dither amplitude during test setup. If three-stage valves are being used, the Valve Drivers panel also allows you to tune the inner loop and make spool conditioner adjustments.
### 3-Stage Valve Drivers (continued)

#### Control Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Driver text box</strong></td>
<td>Shows the name of the selected valve driver. The adjacent driver ID box shows the chassis location, slot location, and channel of the selected driver.</td>
</tr>
<tr>
<td></td>
<td>Select a channel using the <strong>Select...</strong>, <strong>Next</strong>, or <strong>Previous</strong> buttons.</td>
</tr>
<tr>
<td><strong>Select... button</strong></td>
<td>Opens the valve driver list box, from which you can select a channel.</td>
</tr>
<tr>
<td><strong>Next button</strong></td>
<td>Selects the next valve driver in the list.</td>
</tr>
<tr>
<td><strong>Previous button</strong></td>
<td>Selects the preceding valve driver in the list.</td>
</tr>
<tr>
<td><strong>Enabled check box</strong></td>
<td>When checked, sets input of valve driver to zero. (For tuning purposes only).</td>
</tr>
<tr>
<td><strong>Balance slide bar and text box</strong></td>
<td>Adjusts the electrical balance of the servovalve.</td>
</tr>
<tr>
<td><strong>Dither amplitude slide bar and text box</strong></td>
<td>Adjusts the dither applied to the servovalve. You can use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td><strong>Invert polarity check box</strong></td>
<td>Selects inverted or non-inverted valve phasing.</td>
</tr>
<tr>
<td><strong>Readout pop-up menu</strong></td>
<td>Selects a function for direct readout. The choices are:</td>
</tr>
<tr>
<td></td>
<td>Valve current Peamplifier output</td>
</tr>
<tr>
<td></td>
<td>Spool command Post-gain amplifier out</td>
</tr>
<tr>
<td></td>
<td>5 Volt reference</td>
</tr>
<tr>
<td></td>
<td>Spool zero output</td>
</tr>
<tr>
<td></td>
<td>Spool position</td>
</tr>
<tr>
<td></td>
<td>Demodulator filter input</td>
</tr>
<tr>
<td><strong>Interlocks</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Disabled check box</strong></td>
<td>When checked, disables hardware interlocks for the selected channel.</td>
</tr>
<tr>
<td><strong>Reset button</strong></td>
<td>When pressed, resets the hardware interlocks for the selected channel.</td>
</tr>
<tr>
<td><strong>Watchdog Timer indicator</strong></td>
<td>Indicates the status of the watchdog timer.</td>
</tr>
<tr>
<td><strong>Excitation fail indicator</strong></td>
<td>Shows whether excitation has failed. This detector is always enabled, both in hardware and software. Excitation failure causes a system interlock because it may indicate a broken, defective or missing conditioner cable.</td>
</tr>
</tbody>
</table>
3-Stage Valve Drivers (continued)

Control Descriptions (continued)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner Loop Tuning</td>
<td>These adjustments are for three-stage valves only.</td>
</tr>
<tr>
<td>Proportional gain</td>
<td>Adjusts the proportional gain for the selected valve driver. You can use</td>
</tr>
<tr>
<td>slide bar and text box</td>
<td>the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td>Rate gain</td>
<td>Adjusts the derivative rate gain for the selected valve driver. You can</td>
</tr>
<tr>
<td>slide bar and text box</td>
<td>use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td>Rate input</td>
<td>Sets the signal source for rate input as spool position or spool error.</td>
</tr>
<tr>
<td>pull down menu</td>
<td></td>
</tr>
<tr>
<td>Spool Conditioner</td>
<td></td>
</tr>
<tr>
<td>Calibration</td>
<td></td>
</tr>
<tr>
<td>Excitation amplitude</td>
<td>Sets the level of the excitation signal sent to the transducer. You can</td>
</tr>
<tr>
<td>slide bar and text box</td>
<td>use the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td>Demode. phase</td>
<td>Sets the demodulator phase of the conditioner output. You can use the</td>
</tr>
<tr>
<td>slide bar and text box</td>
<td>slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td>Spool zero</td>
<td>Sets the spool position zero offset. You can use the slide bar to set a</td>
</tr>
<tr>
<td>slide bar and text box</td>
<td>value or enter it in the text box.</td>
</tr>
<tr>
<td>Conditioner gain</td>
<td>Adjusts the conditioner gain for the selected valve driver. You can use</td>
</tr>
<tr>
<td>slide bar and text box</td>
<td>the slide bar to set a value or enter it in the text box.</td>
</tr>
<tr>
<td>Invert polarity</td>
<td>Selects inverted or non-inverted spool conditioner polarity.</td>
</tr>
<tr>
<td>check box</td>
<td></td>
</tr>
<tr>
<td>Valve driver input</td>
<td>Shows current value input to the valve driver by the servocontroller.</td>
</tr>
<tr>
<td>display box</td>
<td>Not editable.</td>
</tr>
<tr>
<td>Spool position</td>
<td>Displays the current spool position.</td>
</tr>
</tbody>
</table>
Section 6
Operation

The complex nature of the test system requires that the operator be familiar with all aspects of the mechanical and electrical components of the system prior to performing any of the following operating procedures. MTS recommends that the mechanical and electrical component descriptions in the Operation Manual and the component Product Manuals be studied and thoroughly understood prior to operating the system.

This section contains the most commonly used operating procedures. These procedures should serve as a guideline and reminder of the critical adjustments and checks to be made for each operation. Execution of these procedures requires that the operator be familiar with the reason for the adjustment as well as the method of adjustment. The operating procedures detailed here are:

- Pre-Test Adjustments
- Hydraulic Turn On
- Warm Up
- Test Execution
- Remote Control Pod Operation
- Using the Low Flow/High Flow Shutoff System
- Hydraulic Shutdown
- Emergency Shutdown

As familiarity with the system is gained, these procedures can be altered to suit specific test requirements.

---

**WARNING**

The test system is capable of causing personal injury and damage to the test specimen and/or test facility.

Injury or damage can result from attempting to operate the system and disregarding system safety precautions, warnings, and cautions.
Pre-Test Adjustments

Before applying hydraulic pressure, complete the following adjustments.

Specimen Preparation

- Ensure that the actuators are securely mounted or positioned
- Securely mount the test specimen
- Attach the specimen transducers and cables (if applicable)
- Calibrate the specimen transducers (if required)

Activate the Control System

Turn on electrical power to the PC computer. After the PC has completed booting, turn on the controller and then wait one minute before double clicking on the \texttt{sts.exe} icon located on your PC desktop. The Calibration parameters and default Settings file, \texttt{Settings.set}, will be loaded and the main panel will appear.

If \texttt{Settings.set} does not exist, you will be prompted for a settings file.

Note: When quitting the application, you must wait one minute before restarting the application.

Initial Test Parameter Adjustments

If you wish to use a settings file that you have saved earlier, use the Restore Settings option under the File menu. The hydraulics must be off before you can save settings, restore settings, or quit the application.

This option restores all settings except the following:

- Parameters that appear in any panel under the View menu
- Hydraulic button states (always \textit{Off})
- Run/Stop button states (always \textit{Stop})

Select the Program Source

- Select the Program source on the main panel.

If Function Generator is selected, use the Function Generators panel under the Operation menu to set up the parameters.

If Data Player File is selected, use the Data Player panel under the Operation menu to choose the playout file.

If Remote Application is selected, make sure an ethernet connection exists to the Remote Application.
If Scramnet is selected, use Scramnet as the program source.

If Pod is selected, use the remote control pod to set the setpoint and mode.

Readout Adjustments

- Setup and enable the desired readout devices using the View menu.

System Limit Adjustments

- Adjust limit detector levels.
  
  Use the Limit Detectors panel under the Operation menu to set limit detector levels that ensure the safety of the system components.

- Enable the limit detectors.
  
  Enable the limit detectors on the main panel via the Interlocks Enabled popup menu.
Hydraulic Turn On Procedure

Complete the following adjustments to ensure a safe start-up of the test system.

Final Safety Checks

- Read the operating safety practices detailed in Section 2 of this manual.
- Verify the Pre-test adjustments made in the preceding subsection.

Adjustments

- Reset any interlocks generated during test setup procedures.

Click on the Interlocks Reset button on the Main Panel to clear interlock and limit detection indicators.

If the Interlock indicator does not clear, a hardware interlock or a software limit remains uncleared in the system.

There are two ways to approach the disabling of Interlocks:

1. Disable interlocks on the main panel. This disables all interlocks. It is used only to move the system out of a limit state under hydraulic power. This method creates a global change.

2. Disable the offending limit detector, either by expanding its limit thresholds or by changing its limit action. This method creates an individual change.

If you disable limits, you must re-enable the interlock on the main panel once the system has been moved to a non-limit condition.

If you suspect a hardware interlock:

A. Check the Conditioners panel to see if a red fault indicator has been set. If a conditioner channel is interlocked, move the limits outside of the current signal value, press the Conditioners Reset button and then return the limit setting to its original value.

B. Click on main panel Interlocks Reset button to clear the hardware interlock indicators.

If you suspect a software limit detector is set:

A. Open the Message Log panel from the View to see if a software limit detector remains uncleared. The message will identify the limit detector.
B. Open the Limit Detectors panel from the Operation menu, and select the associated signal. Make a note of the limit value. Then, move the limits outside of the current signal value and press the main panel (Interlock) Reset button to clear the software interlock indicators.

C. Open the Limit Detectors panel from the Operation menu, and set the limit detector you adjusted in Step B back to its original value.

Make sure system is in Stop mode by clicking on the Stop button on the main panel.
Hydraulic Start-up

**WARNING**

Actuator movement may occur when the HSM Lo button is pressed.

Actuator movement can result in injury to personnel or damage to the specimen.

Ensure that all personnel are clear of the actuator(s) or fixturing before pressing the HSM Lo button

- Click on the HSM 1-9 buttons to select the desired HSMs.
- Verify the gain settings for stable system control. Decrease the Master Gain control on the main panel, if necessary.
- Apply low pressure at the hydraulic service manifold by clicking on the HSM LO button. The Low Pressure indicator on the Main panel will turn yellow when the system reaches low pressure.
- Apply high pressure at the hydraulic service manifold by clicking on the HSM Hi button. The High Pressure indicator on the Main panel will turn green when the system is in high-pressure mode.
- Slowly restore the Master Gain control to 100%, while verifying control stability.
Warmup Procedure

- Run a low frequency, low amplitude sine wave until oil temperature is at or above 32°C.
Test Execution Procedure

After applying hydraulic pressure to the actuators, complete the following procedure to execute a test.

Verification and Safety Checks

*Note*  
Optimum system response is achieved when the hydraulic fluid is at its normal operating temperature.

- Ensure that the hydraulic system is at its normal operating temperature (at or above 32° C) before proceeding with testing. (Refer to previous Warmup Procedures section)
- Check the program input and pre-test adjustments completed in the preceding subsections.
- Clear all personnel from the test area.

Starting the Program

**CAUTION**

When adjusting the SPAN and SETPOINT controls, ensure that the test program does not exceed 100% of the full-scale limits.

The SPAN and SETPOINT controls can cause the program to exceed 100% of the system full-scale limits.

- Verify that the Desired Span control (program amplitude) on the main panel is set to a known safe operating level or 0%.
- Verify the program source selection and parameters.
- Verify the correct control variable is selected.

**WARNING**

Immediate and unexpected actuator response is possible when a Run command is applied to the system.

Unexpected actuator response can result in personal injury or equipment damage.

Clear all personnel from the test system before running a test.

- Press the Run button on the main panel to begin the test.
Adjustments During a Test

- Make adjustments to the readout devices as desired.
- Minor adjustments to the Desired Span control can be made at this time.

While constantly checking for system stability, slowly adjust the main panel Desired Span control towards 100%.

If the system becomes unstable, immediately remove hydraulic pressure by pressing the EMERGENCY STOP button. Identify the cause(s) of the instability before attempting the test again.

Stopping a Test

- Click on the Stop button on the main panel to stop the test. Span will ramp to zero. System returns to setpoint levels

- Click on the Abort button on the main panel to abort the test. Motion is halted, setpoints are updated to current feedback levels, and span is zeroed.

- Click on the Pause button on the main panel to pause the test. Motion is temporarily halted. Clicking on the Pause button again will resume motion.
Remote Control Pod Operation

The Remote Control Pod can be used to manually set the system setpoints and mode. An Abort button is also available to initiate an abort if necessary. An E-stop button is located on the pendant to be used in emergency situations.

The pendant has several control buttons that are used for entering in commands. These buttons are described in more detail in the table below.
<table>
<thead>
<tr>
<th>BUTTON</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up and down buttons</td>
<td>Moves the highlight cursor from one field to another.</td>
</tr>
<tr>
<td>Left and Right arrow buttons</td>
<td>Changes the value of the currently selected field. If the field is a number control field, the change is a function of the step size button. The Left arrow decreases the value and the right arrow increases the value. The command change is executed as soon as the button is pressed. If the field is a combo box field, pressing the left or right button changes the display to the next available selection in the combo box. The Enter button needs to be pressed to make the selection final.</td>
</tr>
<tr>
<td>Panel -&gt; Setpoints</td>
<td>Shows the Setpoints panel. Used for manually selecting force or displacement mode and setting an actuator setpoint. Note that all the controls in this panel are disabled when a program is executing.</td>
</tr>
<tr>
<td>F1, F2, F3, F4 buttons</td>
<td>Currently not used.</td>
</tr>
<tr>
<td>Enter Button</td>
<td>Acknowledges changes in Combo Box control fields. This also hides the highlight cursor when pressed.</td>
</tr>
<tr>
<td>Station Stop Button</td>
<td>Initiates an Abort. HSMs will shut down.</td>
</tr>
<tr>
<td>Coarse</td>
<td>Sets a coarse step size for any number control field in the panel.</td>
</tr>
<tr>
<td>Medium</td>
<td>Sets a medium step size for any number control field in the panel.</td>
</tr>
<tr>
<td>Fine</td>
<td>Sets a fine step size for any number control field in the panel.</td>
</tr>
<tr>
<td>Enable/Disable Button and Indicator</td>
<td>Enables or disables the Encoder wheel used for changing number control fields in the panel. Encoder wheel is enabled when indicator is lit.</td>
</tr>
<tr>
<td>Encoder Wheel</td>
<td>If enabled, changes the value of the currently highlighted number control field. Clockwise rotation increments the value, Counter-clockwise decrements the value. The step size is determined by the Step size buttons (course, medium, and fine).</td>
</tr>
</tbody>
</table>
Changing Mode and Setpoints with the Remote Control Pod

Complete the following procedure to change the mode and setpoints using the Pod.

Verification and Safety Checks

- Ensure that there are no obstructions

Change Settings

1. Turn on hydraulics from the Main Panel.

2. Select Pod as the program source on the Main Panel. The Pod will show the screen below.

3. Select an actuator by using the Up and Down arrows to tab through screen selections until you get to the Channel textbox. Use the Left and Right arrow buttons to select the desired actuator. Press Enter to finalize the change.

4. The control modes of the actuators can be changed by using the Up and Down arrows to highlight the Mode text box. Use the Left and Right arrow buttons to change the desired mode. The Enter button must be pressed to finalize the change.

5. The setpoint of the actuator can be changed by using the Up and Down arrows to highlight the Displ or Force text box. Press Enter to finalize the change. Use the Left and Right arrow buttons or enable the encoder wheel to change the setpoint. The Enter button must be pressed to finalize the change.
Using the Low Flow/High Flow Shutoff System

MTS has provided a servovalve bypass option to allow you to run the actuators more slowly.

**Low Flow - Low Speed Actuator Operation**

1. Pull and turn the red knob 90° to lock the knob in place, activating the 3-stage servovalve shut-off poppets. In this position, oil flow from the 3-stage servovalve to the actuator control ports is blocked.

2. Using a 1” wrench, turn the 2-stage servovalve shut-off spool until the indicator pin points to “OPEN”. This allows flow from the 2-stage servovalve to control actuator movement.
High Flow - High Speed Actuator Operation

1. Using a 1” wrench, turn the 2-stage servovalve shut-off spool until the indicator pin points to “CLOSE”. This blocks oil from the 2-stage servovalve to the actuator control ports.

2. Slightly pull and turn the red knob 90° until the lock position pin is aligned with its slot. Release knob into its spring-return, depressed position. This will deactivate the 3-stage servovalve shut-off poppets and allow the 3-stage servovalve to control actuator movement.
Hydraulic Shutdown Procedure

After the completion of a test, the following procedure should be completed to ensure safe shutdown of the test system.

---

**Note**  Do not use the EMERGENCY STOP (or E-STOP) buttons during routine system shutdown. An emergency shutdown bypasses normal shutdown control sequences and, if used for routine shutdown, will place unnecessary mechanical strain on the system.

---

**System Shutdown**

- If necessary, press the **Stop** button on the main panel to stop the test.
- Toggle the **HSM Hi** button to put the system in low pressure mode.
- Toggle the **HSM Lo** button to close the HSMs.
Emergency Shutdown Procedure

The following actions should be taken if an emergency arises during operation of the test system.

---

**Note**  If the system electronics senses an exceeded limit or open interlock condition, a system shutdown will be activated automatically.

---

- If an emergency situation occurs, activate an emergency shutdown by pressing one of the large red EMERGENCY STOP (or E-STOP) buttons. These buttons are located on the control console desk and the remote control pod.
- Correct the condition that caused the emergency shutdown.
- Execute the Hydraulic Turn On Procedure.
Section 7
Maintenance

The Structural Test system demands periodic, routine maintenance to continue to provide optimum performance. This section contains lists of recommended preventive maintenance schedules for the system components supplied by MTS, and a system maintenance log. For corrective maintenance information, refer to the Maintenance Procedures section or contact MTS Systems Corporation.

A thorough understanding of the system's nature should be achieved by reading the system manuals and studying the equipment before any maintenance procedure is begun.

Some repair or maintenance procedures may require the use of heavy machine rigging techniques. This manual is not intended to be a primer in this area and assumes knowledge of such techniques and the use of personnel skilled in rigging.

General Inspection Criteria

Before performing any maintenance routine, read the safety practices in Section 2 of this manual and the maintenance procedures in the applicable product manuals. Any system component not specifically discussed in this section or in other sections should not be adjusted or tampered with. Consult MTS Systems Corporation about any problems concerning adjustment of such components.

⚠️ WARNING

The Safety Practices section of this manual contains information that can help maintenance personnel minimize hazards which can be encountered during system maintenance.

Failure to observe the Safety Practices described in this manual prior to attempting the following maintenance procedures can result in injury to personnel and/or damage to equipment.

Ensure that all persons involved in the maintenance of the equipment read the Safety Practices section of this manual.
In order to maintain a safe system, it is very important to contact the MTS Service Department immediately if any of the following conditions are noted:

- Excessive nitrogen leakage.
- Any bolt or nut fastener failure or any sign of loss of bolt preload, even if the bolt appears to be defective or if the system has been operated with insufficient torquing through oversight.
- Any operation or maintenance procedure that may have accidentally overloaded any structural component.
- Any loss of system control or unexplained tripping of the limit detector interlocks.
- Any unexplained loss of hydraulic fluid from the system reservoir.

**System Operating Inspections**

Check for normal system operation whenever the system is run. In addition to the maintenance safety checks listed in Section 1, routine operation inspections should consist of checks for the following:

- Fluid level in the hydraulic power supply reservoir is normal (as indicated on the reservoir fluid level gage).
- Nitrogen precharge in the accumulators is within ±20% of posted pressure.

**Preventive Maintenance Checklist**

Most system maintenance is limited to routine inspections for signs of obvious component damage or failure and maintenance of the correct nitrogen precharge for the accumulators. The following subsections briefly describe specific maintenance tasks. Refer to the appropriate Product Manuals, for detailed maintenance procedures.

**WARNING**

The hydraulic pump must be turned off before any maintenance procedure is begun. Follow established company safety procedures to assure that the unit cannot be operated while maintenance is being performed.
The time between maintenance intervals may require re-evaluation and may change from the specified interval due to experience gained after the system has been in operation.

**Before Starting a Test**

**General inspection before starting a test.** Inspect the test area for damage or obstruction (e.g., forgotten tools, etc).

**Check oil temperature.** Ensure that the hydraulic system is at its normal operating temperature (at or above 40°C) before proceeding with a test.

**After Completing a Test**

**General inspection after completing a test.** Inspect the system for obvious signs of cracking, buckling, loose bolts, leaks, or other conditions requiring maintenance or repair. If any of these conditions are found, contact MTS Systems Corporation.

**As Required**

**Replace HSM filter.** Replace HSM filter whenever its indicator pops out.


**Replace actuator seals.** Replace the piston rod seals whenever leakage occurs or whenever the actuator has been disassembled. A decrease in system performance can also be an indication of seal wear.


**Replace accumulator seals.** Replace accumulator seals whenever leakage occurs.


**Check Servovalves.** The servovalves should have a periodic checkup and possible reconditioning. MTS has a valve exchange program to facilitate this. The actual running time of the system will determine the replacement interval for the servovalves.

Each Shift

Check hydraulic fluid level, color and odor. Check the fluid level to ensure that it is within the correct operating range. A below normal level would indicate a loss of hydraulic fluid. If below normal, inspect the system for leakage, correct the problem, and refill it to the proper level. Check the fluid color and compare it to the first test sample taken after initial system installation. Check the smell of the hydraulic fluid. If necessary, replace the hydraulic fluid.

Weekly

Inspect all safety devices. It is important to inspect all safety devices to ensure operator safety.

• Refer to Product Manuals for specific safety precautions and features.

Inspect hydraulic components. Inspect the hoses, hard line, pressure sensors, gages, and hose connections for signs of damage, wear or leakage. Correct any problem that exists.

Clean actuator piston rod. Clean the exposed area of the hydraulic actuator piston rods.


Check actuator and attachment hardware. Check the actuator and attachment hardware for any sign of damage. Correct any problem that exists.

Clean exposed areas. Clean all exposed areas of the test system including transducers and servovalues.

Check E-Stop safety devices. It is important to check the E-Stops to ensure operator safety. The E-Stops should be tested for proper operation. Run a “dummy” test, hit the E-Stop, and ensure that the system operation stops.

Monthly

Inspect all bolts. Inspect bolts for obvious signs of looseness or structural failure. Correct any problem that exists.

Check hoses. Check hoses for wear or damage.
Check accumulator precharge levels. Check precharge of all accumulators. If the accumulator pressures are outside of the accepted levels, charge or discharge the accumulators.


Run the system. Start the system and allow it to reach operating temperature on a monthly basis. This action drives moisture out of the system and lubricates components that may have drained while inactive.

Every 3 Months

Check calibration. Check calibration of the feedback devices, re-tune if necessary.

[Operation Manual– Calibration]

Every 6 Months

Check accessible cap screws. Check the torque of all accessible cap screws of size M16 or larger. Tighten if necessary. Reference torque tables or appropriate drawings.

[Reference Manual, Actuator Assemblies for the 244.xxx]

Check HSM pilot operated pressure reducing valves. Check the setting of the pressure reducing valves and adjust if necessary. Adjust as follows:

- Reduce pressure on both valves by loosening lock nut and turning counter-clockwise.
- Turn one valve clockwise to raise pressure to desired output. Then, adjust second valve with clockwise motion to a pressure greater than the desired output.
- Reduce pressure of second valve until setting of each valve is equal.
- Lock valves in place with lock nuts.

Analyze hydraulic fluid sample. Take a sample of the hydraulic fluid and have it analyzed. Replace the fluid if necessary. Oil condition is critical for servovalve and internal cylinder component life.

Yearly

Replace actuator seals (low pressure). Replace the low pressure actuator seals whenever leakage occurs or whenever the actuator has been disassembled. A decrease in system performance can also be an indication of seal wear.


Every 5 Years

Replace hoses. Replace any hoses that show signs of wear or damage immediately. Even with no apparent flaws the hoses should be replaced every 5 years due to natural aging of the hose material.
System Maintenance Log

The system maintenance log is a tool to use for recording and tracking maintenance. The maintenance interval/date of maintenance entries should be made when the maintenance is actually performed. An example maintenance log is illustrated in the Figure below.

Example System Maintenance Log

It may be helpful to maintain separate logs for maintenance procedures that are required weekly, monthly, yearly, etc.
Overview

The Calibration section explains how to calibrate devices using the following panels:

- Analog Inputs
- AC/DC Conditioners
- Encoder Conditioners

The Tuning section explains how to tune the 256 Valve Inner Loop.

A/D Converter Calibration

A/D Converter Calibration Procedure

To calibrate an A/D converter, take the following steps:

1. Select the desired A/D channel.
2. Ground the input signal.
3. Adjust the Gain control to +1.00.
4. Adjust the **Offset** control until the current value reads 0.00V.

5. Input a DC signal between 0V and 10V from a calibrated voltage source such as a D/A or a power supply.

6. Adjust the **Gain** control until the current value displayed matches the value of the signal input from the calibrated voltage source.

7. Remove the calibrated voltage source.

8. When the calibration procedures are completed, select **Save settings** from the **File** menu on the main panel to save the new calibration settings.

**D/A Converter Procedure**

No D/A calibration procedures should be necessary. Consult MTS Systems Corporation if calibration concerns arise.
Calibration (for a displacement channel) means adjusting displacement to correspond to a pre-defined maximum and minimum voltage.

The AC Conditioner uses a reactive type transducer such as a linear variable differential transformer (LVDT). This transducer measures bidirectional displacement from a zero reference position.

To calibrate an AC Conditioner displacement channel, complete the following steps:

**NOTE**: Turn on the console and allow the modules to warm up properly (approximately 5 minutes) before you make any electrical adjustments.

1. Select the AC/DC Conditioners option from the **Calibration** menu on the main panel.
2. Select the desired AC Conditioner displacement channel.
3. Adjust the **Gain**, **Excitation**, and **Delta K** controls to the respective values listed on the original calibration sheets, or set **Gain** to approximately 3 V/V, **Excitation** to 10.000 Vpp, and **Delta K** to 1.000 V/V (these are the approximate midpoint values for each control).

4. Set the displacement engineering units for this conditioner, for example, +10.000 V = 6.000 in. and -10.000 V = -6.000 in.

5. Set the control mode for the control channel to **DISPLacement** via the **Setpoint** panel.

6. Select **HSM Lo** on the main panel. Adjust the **Setpoint** control to fully retract the actuator without positioning it in the end cap.

7. Remove the Hydraulics.

8. Adjust **GAIN** so the conditioner output is less than -10.000 V.

9. Adjust the **Demod phase** to maximize the output of the conditioner.

10. Apply the Hydraulics.

11. Adjust **Setpoint** to obtain a reading of zero from the conditioner.

12. Connect a displacement measurement device to the actuator rod.

13. Move the **Setpoint** to full scale negative displacement.

14. Reduce the **GAIN**, if required, so that the actuator rod is in the end cap. Record the displacement reading when fully retracted.

15. Move the **Setpoint** to full scale positive displacement.

16. Reduce the **GAIN**, if required, so that the actuator rod is in the end cap. Record the displacement reading when fully extended.

17. Half of the difference between the fully retracted and fully extended displacement readings will be the zero point of actuator displacement.

18. Move the **Setpoint** to zero displacement.

19. Adjust the **ZERO** until the displacement measurement device is reading half the difference between the fully retracted and fully extended displacement readings.

20. Move the **Setpoint** to full scale negative displacement.
21. Adjust conditioner **Gain** until the displacement measurement device reads the correct full-scale displacement.

22. Repeat steps 17-21 until zero and full-scale are within desired tolerance.

23. Adjust **Setpoint** to full scale positive displacement.

24. Adjust **Delta K (+)** (on the AC Conditioners panel) until the displacement measurement device reads the correct positive full-scale displacement.

25. Plot the actuator linearity by recording the conditioner output values from the displacement conditioner for ±20%, ±40%, ±60%, ±80%, and ±100% of full-scale.

   a. For example, adjust **Setpoint** for a dial indicator readout of 15 mm (+20%). Record the conditioner output values on your transducer calibration sheet. Repeat this step for ±20%, ±40%, ±60%, ±80%, and ±100% of full-scale displacement.

---

**NOTE**  
*The accuracy tolerance (linearity) should be ±1% of full-scale. Therefore, in the example above, 15 mm should indicate a range between 1.90 to 2.10 Vdc on the conditioner output. If not, return to step 1.*

---

26. When the AC Calibration procedures are completed, **Save settings** from the **File** menu on the main panel to save the new calibration settings.
DC Conditioner Calibration

The DC Conditioners are used for different types of feedback: force, pressure and acceleration. Force is measured using a load cell, pressure is measured using a differential pressure cell and acceleration is measured using an accelerometer. Each has its own calibration procedure.

The DC Conditioners are used for different types of feedback: force, pressure and acceleration. Force is measured using a load cell, pressure is measured using a differential pressure cell and acceleration is measured using an accelerometer. Each has its own calibration procedure.
Force Transducer Calibration

To calibrate a DC Conditioner for use with a load cell:

---

**NOTE** Turn on the console and allow the modules to warm up properly (approximately 5 minutes) before you make any electrical adjustments.

1. Select the AC/DC Conditioners option from the **Conditioners** menu on the main panel.
2. Select the DC Conditioner channel for the force feedback.
3. Install a calibration reference load cell in series with the system load cell to verify accurate force feedback settings. Connect the reference cell to it’s corresponding electronics so you can monitor the output readings from the reference load cell.
4. Set the displacement engineering units for this conditioner to volts, for example, +10.000 V = 10.000 V and –10.000 V = - 10.000 V.
5. If necessary, adjust the **Excitation**, **Gain** and **Delta K** controls to the respective values listed on the original calibration sheet.
6. Couple the actuator to the load and calibration cells.
7. Set the control mode for the control channel to FORCE via the **Setpoint** panel.
8. Adjust the **Setpoint** control (on the Setpoint panel) to zero force.
9. Apply LOW Hydraulic pressure via the HSM.
10. Adjust the ZERO control until zero force is indicated on the calibration cell readout.
11. Adjust the **Setpoint** control (on the Setpoint panel) to zero force.
12. Apply HIGH Hydraulic pressure via the HSM.
13. Adjust the ZERO control until zero force is indicated on the calibration cell readout.
14. Move the **Setpoint** to – 80% full scale force.
15. Adjust the GAIN until the calibration cell reads out – 80% force.
16. Repeat steps 11-15 until zero and – 80% are within desired tolerance.
17. Adjust **Setpoint** to + 80% positive force.
18. Adjust **Delta K (+)** (on the AC/DC Conditioners panel) until the calibration cell reads +80% force.
19. Plot the force load cell linearity by recording the conditioner output values from the force conditioner for ±20%, ±40%, ±60%, ±80%, and ±100% of full-scale by setting the SETPOINT value in the Setpoint window and reading the actual force on the calibration load cell readout.

The accuracy tolerance (linearity) should be ±1% of full-scale. Therefore, in the example above, 15 mm should indicate a range between 1.90 to 2.10 Vdc on the conditioner output. If not, return to step 1.

20. When the DC Calibration procedure is completed, Save settings from the File menu on the main panel to save the new calibration settings.

Differential Pressure Transducer (Delta P) Calibration

To calibrate a DC Conditioner for use with a differential pressure cell:

NOTE Turn on the console and allow the modules to warm up properly (approximately 5 minutes) before you make any electrical adjustments.

1. Select the AC/DC Conditioners option from the Conditioners menu on the main panel.

2. Select the DC Conditioner channel for the delta P feedback.

3. Disconnect the differential pressure cell from the actuator, being careful to note its orientation.

4. Attach an appropriate, calibrated pressure source to the differential pressure cell input labeled P1. The pressure source must meet the capacity of the differential pressure cell and have a higher accuracy than the differential pressure cell. (MTS recommends using a dead weight pressure tester).

5. If necessary, adjust the Excitation and Gain controls to the respective values listed on the original calibration sheet.

6. Apply a pressure as close to 100% capacity of the system as possible. Then apply zero pressure and adjust the "ZERO" value on the DC Conditioner panel until the "Conditioner Output" equals 0V. Repeat step 6 two more times.
7. Apply a known exact pressure at 80% capacity of the system. Calculate the ideal DC conditioner output value for this pressure and compare it with the actual DC Conditioner output value. The actual value should be within the permissible variation of the ideal calculated value. (Refer to the original calibration sheet for the permissible variation). If the actual value is not within the permissible variation, adjust the Gain setting on the DC Conditioner panel until it is.

8. Apply pressures equal to 20%, 40%, 60%, and 100% capacity of the system. Monitor the conditioner output values to make sure these values are within specification. (Refer to the original calibration sheet for the permissible variations).

9. Readjust the 80% gain if any values are out of specification by going back to step 7.

10. Disconnect the pressure source from the differential pressure cell input labeled P1 and connect it to the differential pressure cell input labeled P2.

11. Apply a known exact pressure at -80% capacity of the system. Calculate the ideal DC conditioner output value for this pressure and compare it with the actual DC Conditioner output value. The actual value should be within the permissible variation of the ideal calculated value. (Refer to the original calibration sheet for the permissible variation). If the actual value is not within the permissible variation, balance the error between the two sides of the differential pressure cell (P1 and P2) by readjusting the gain appropriately.

12. If desired, repeat the measurements for ±20%, ±40%, ±60%, ±80%, and ±100% of fullscale. Record the conditioner output values on your transducer calibration sheet.

13. When the DC Conditioner calibration procedure is completed, select Save settings from the File menu on the main panel to save the new calibration settings.

14. When the calibration is complete, disconnect the pressure source from the differential pressure cell, and reconnect the differential pressure cell to the actuator according to its original orientation.
Accelerometer Feedback Calibration

To calibrate the DC Conditioner for use with an accelerometer:

---

**NOTE**  Turn on the console and allow the modules to warm up properly (approximately 5 minutes) before you make any electrical adjustments.

---

1. Select the AC/DC Conditioners option from the Calibration menu on the main panel.

2. Select the DC Conditioner channel for the acceleration feedback.

3. Mount the accelerometer to be calibrated onto a portable accelerometer calibration stand with a built-in exciter.

4. Connect the output of the exciter to Channel 1 of a dual trace oscilloscope.

5. Connect the Calibration Service cable to the RJ45 connector at the top of the 493 I/O carrier that has the DC conditioner daughter card installed. Select the BNC cable that corresponds to the slot that the DC conditioner daughter card is plugged into and connect that BNC cable into channel 2 of the oscilloscope.

6. Adjust the zero value on the DC Conditioner panel until the "conditioner output" equals 0V.

7. Adjust the exciter so that a known amount of acceleration is being delivered to the accelerometers. Verify this by viewing the peak to peak voltage on channel 1 of the oscilloscope.

8. Adjust the gain level on the DC Conditioner board until the peak to peak output voltage of the DC Conditioner (channel 2) corresponds to the acceleration shown on channel 1. Since the output voltage scaling of the reference accelerometer and the system accelerometer may be different you have to calculate the actual p-p voltage that will be output by the DC Conditioner.

9. When the DC Conditioner calibration procedure is complete, select Save settings from the File menu on the main panel to save the new calibration settings.

10. Remove the calibration equipment and restore system to its normal configuration.
Linear Encoder Calibration

Calibration of the Linear Encoder means adjusting the sensitivity in counts per volt to correspond to a known displacement.

The Encoder Conditioner uses a count/volts to measure bidirectional displacement from a zero reference position.

To calibrate an Encoder Conditioner stroke channel, complete the following steps:
NOTE  Turn on the console and allow the modules to warm up properly (approximately 5 minutes) before you make any electrical adjustments.

1. Select the Encoders option from the **Calibration** menu on the main panel.

2. Select the Encoder channel.

3. Ensure that the Encoder Type is set to **Incremental 24 Bit**.

4. Set the sensitivity to the number of counts the encoder outputs in one inch if you want 1 inch to equal 1 volt.

NOTE  The accuracy tolerance should be ±10 um. (.0004 in.)

5. When the Encoder Calibration procedure is complete, select **Save settings** from the **File** menu on the main panel to save the new calibration settings.
256 Valve Inner Loop Tuning

A programmable digital controller controls the position of the third stage pilot valve spool, which in turn controls the flow of hydraulic fluid to the actuator. Valve spool position is measured using a LVDT (linear variable differential transformer). Inner loop tuning consists of setting the LVDT conditioner settings, and tuning the analog controller servo loop gains.

Equipment

The following equipment is required for inner-loop tuning.

493 I/O Carrier service cables (P/N’s 100-026-162 and 100-026-163)
**Spool Conditioner Gain**

An LVDT is used to measure the position of the third stage pilot spool in a 3-stage servo valve. The 3-stage valve driver card provides excitation and conditioning for this transducer. The first step in inner-loop tuning is setting the spool conditioner adjustments.

- Open the **3-Stage Valve Drivers** panel.

- Attach the service cable to the I/O Carrier card housing the 493.15 valve driver card. The position of the valve driver card in the carrier card determines which channel to use on the service cable. (see the Valve Drivers Panel to determine the chassis and slot number of the 493.15).

- Attach the appropriate service cable channel output to an unused User A/D input on the controller.

- Turn hydraulic power ON. This provides pilot pressure to the 3-stage servo valves while preventing the actuator from moving.

- Set the Spool Conditioner adjustments to the following initial values:

  - Excitation: 10 Vpp
  - Demodulator Phase: 22.5 deg
  - Spool Zero Offset: 0 V
  - Conditioner Gain: 10.0 V/V
  - Conditioner Polarity: Inverted

- Select **Spool Position** in the Rate input readout pop-up menu. Monitor this signal using the User A/D input selected earlier.

- Set the Inner Loop Tuning **Proportional gain** to zero. This will allow the third stage pilot spool to float into one of the end caps.

- Adjust the **Demodulator phase** to maximize the Spool Position feedback value.

- Adjust the **Conditioner gain** so that the amplitude of the spool position feedback is 10 volts. The spool position feedback may be ±10 volts depending on the mechanical bias of the servo valve.
j. Use the valve **Balance** to drive the servo valve into the other end cap (change the sign of the spool position feedback). If the amplitude of the spool position feedback exceeds 10 volts, lower the conditioner gain setting until spool position feedback reads 10 volts.

**Servo Gain Tuning**

The digital controller has programmable proportional and derivative gain terms that are set using the valve driver panel.

a. Open the **3-Stage Valve Drivers** panel.

b. Attach the service cable to the I/O Carrier card housing the 493.15 valve driver card. The position of the valve driver card in the carrier card determines which channel to use on the service cable. (see the Valve Drivers Panel to determine the chassis and slot number of the 493.15).

c. Attach the appropriate service cable channel output to an unused User A/D input on the controller.

d. Use the Oscilloscope to monitor the selected User A/D input.

e. Turn hydraulic power ON. This provides pilot pressure to the 3-stage servo valves while preventing main pressure from reaching the machine.

f. Select **Spool position** in the Rate input readout pop-up menu of the valve driver panel.

g. Set the Inner Loop Tuning **Proportional gain** to 0.0 and the **Rate gain** to 0.0.

h. Open the **Function Generator** panel, set up square wave to 1 Hz. and start with small amplitude such as 5 to 10%.

i. Use the oscilloscope to view the spool position feedback signal. On the **Valve Driver** panel, raise the proportional gain until the spool begins to overshoot.
j. Adjust the valve Balance until the overshoot is the same in the positive and negative directions.

k. Raise the Rate gain to dampen out the overshoot. Raise the Proportional gain to achieve overshoot, then dampening out the overshoot using rate gain. Continue this iterative cycle until the feedback begins showing some sawtooth waveform or instability occurs. Back off proportional and derivative (rate) terms for clean rise and corner move to horizontal.

Spool Zero Adjustment

Ideally, setting the valve drive signal to zero should result in no motion in the system and minimum oil flow. Realistically, all three stage valves have a little mechanical/electrical bias that must be adjusted out. This is done using the spool zero adjustment and adjusting the spool LVDT position.

a. Open the Digital Meter panel and select the valve drive signal.

b. Turn the hydraulic power and HSM to High.

c. Adjust the Spool zero value in the valve driver panel to zero.

d. Loosen the locknut on the spool LVDT and slowly move the LVDT in or out until the valve drive signal displayed by the digital meter is zero. Tighten the locknut on the LVDT such that the valve drive signal remains as close to zero as possible.

e. Adjust the spool zero value in the valve driver panel to a value that results in zero valve drive.
Appendix A
Signal Name Lists

Overview
This appendix contains a list of signals that can be monitored at one or more of the display panels (such as oscilloscope, digital meter, and data recorder).

Signal List
The following signals are available for each actuator:

Displacement Command
Displacement Feedback
Displacement Error
Force Command
Force Feedback
Force Error
Scramnet command
Slave Command
DP Force Feedback
Valve Command
Valve Spool Position
User A/D (1 – 12)
User DUC (1 – 8)
Unity